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Hallmark Card Studio™ | Welcome to Hallmark Comedy Card Studio™

Welcome to Hallmark
- Comedy Card Studio™

Hallmark™ Comedy Card Studio™ was created to help you easily design personal-
ized greeting cards that express your thoughts and feelings. And, because your per-
sonal communication needs may require more than a greeting card, Hallmark
Comedy Card Studio includes features that let you make outstanding envelopes,
stickers, labels, stationery, invitations, postcards, announcements, and calendars.

Card Studio includes Event Planner, an electronic calendar and Address Book. Use
the calendar to keep track of all your important activities. Use the Address Book to
maintain your personal mailing and e-mailing list, plus birthdays and anniversaries for
all the special people in your life. Event Planner can even remind you of all your
upcoming events so you have time to create the perfect card or other appropriate
items for the occasion.

!E = v ‘E *- Any time you want to celebrate a birth-

day, write a romantic note, or say thanks
for a great job, Card Studio can help
you put the right art and words togeth-
er on paper. Just select a card or other
product from the Card Studio Activity
screen.

Card Studio

My )
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Using the Manual with
Card Studio Programs

The manual contains procedures for selecting, personalizing, printing, and folding your
cards. Then, it explains how to work with each of the other product types, including
the products designed for Hallmark Papers.

The manual lists all product types for all non-card products in alphabetical order.
When it's time to create a product—for example, a newsletter—just locate the sec-
tion for the product, and follow the instructions for that product type.
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Hallmark Card Studio™ | Working with Hallmark Papers

Working with Hallmark Papers

Card Studio includes templates for printing with many types of preprinted Hallmark
Papers, including:

*  Cards

*  Newsletters
» Postcards

* Labels

* Invitations

When you select one of the Hallmark Paper products in the Card Studio program,
the preprinted area of the paper is displayed as a nonprintable layer in the Art
Studio. You can change to another nonprintable layer if you want. Or, try printing a
predesigned Card Studio product on Hallmark Papers! Use the nonprintable layer to
place text or graphical elements exactly where you want in relation to the designs
on the preprinted Hallmark Paper.

When you are done creating your card, newsletter or other product in the Card
Studio program, you can print on the Hallmark Papers you've purchased. When
printing your creations, you can be assured of quality results when you use Hallmark
Designed Computer Papers, card stock, and envelopes. You can find Hallmark
Computer Papers at Hallmark retailers, office supply stores, on our web site at
http://www.hallmark.com.

to Contents 3 to Index
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Hallmark Card Studio™ | Card Studio Features

Card Studio Features

Greeting Cards for All Occasions

Card Studio has thousands of designs for different card-giving occasions! You'll find

everything you need—from birthday and holiday cards to anyday, electronic, and
photo cards.

There are two easy ways to choose the design that's just right:

* Select a card group on the main Activity screen. Or, select Hallmark Papers and
select Cards. Then select an occasion and browse through the choices. Once
you've found the right card, you can easily personalize the message.

* Find a Card. Find a Card is another way to select a greeting card. Find a Card
saves you time by letting you search through several categories you select.

A Note About Other Products

Although many of the instructions on the following pages refer specifically to cards

(including invitations and announcements), you can follow the basic steps to create

envelopes, stickers, labels, stationery, postcards, calendars, and other products. Card
Studio gives you options for these types of personal communication forms, too.

Art Studio

Although we've given you lots of options in all categories, we know you have your
own ideas. Express them in the Art Studio. You can mix and match greetings,
designs, clip art, and photos from our Art Book, or you can create drawings and text
from scratch. You can even import your own photographs for an extra special
touch. The Art Studio lets you be as inventive as you want to be!

to Contents 4 to Index



Hallmark Card Studio™ | Card Studio Features

Sending Your Cards Using the Internet

You can send your card using your Internet connection to e-mail your card directly
to the recipient. When the recipient receives the card, he or she can view one
panel at a time on the computer screen.

Note: Recipients using non-Windows operating systems may not be able to
open e-mailed cards.

Kid Lock

Card Studio contains a wide variety of content for all ages, including content special-
ly designed with children, teens, and adults in mind. The content of cards is based on
continuing research of purchasers of greeting cards and meets the needs of a cross-

section of ages and interests.

With this in mind, we were concerned that young eyes might have more access to
the diversity of cards in our program than they do in retail stores. Therefore, we
added the Kid Lock feature to give parents more control over what children see.

Gerting Organized with Calendars

The Event Planner Calendar features an easy-to-read format. The right side of the
screen shows a regular monthly calendar with all your scheduled events and holidays
easily identified. The left side of the screen has a Details list for a specific day you
select. The Calendar enables you to enter notes for special one-time events (your
20th year high school reunion) and regularly scheduled activities (soccer practice
every Saturday morning).

In Hallmark Comedy Card Studio, you can print Calendar products with Hallmark’s
designs, or you can create calendars with your own artwork. When you print calen-
dars, you can choose to have events that you entered in the Event Planner calendar
printed on the decorated calendars.

to Contents 5 to Index



Hallmark Card Studio™ | Card Studio Features

A Special Address Book

Naturally, the Address Book is used to enter mailing information for your family and
friends. There's even space for an e-mail address and phone numbers. It's also used
to enter birthday and anniversary dates. It's easy to use the entries from the Address
Book to print envelopes and labels for your cards and letters. Card Studio even
enables you to enter an alternate mailing name so that you have options for
addressing the mail going to one household. For example, you can have Mr. and
Mrs. John Smith and The John Smith Family as addressing options.

Lvent Planner Reminders

Any time you enter a note on your Calendar, or a birthday or anniversary in your
Address Book, you can choose to be reminded before the day of the event.
Reminders display in a special area on the Calendar. You can even choose to have
reminders display automatically in a special box every day. When you get your
reminder, use Card Studio to design the perfect card or other creation for the
occasion.
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Gerting Started

Take time to check the System Requirements listed below before following the easy
installation instructions. You'll be creating your own unique cards in just a few min-
utes!

System Requirements

To run Card Studio effectively, your system needs to meet the following minimum
hardware and software requirements:

*  An IBM™-compatible computer with a 100 MHz or higher microprocessor
*  Microsoft™ Windows™ 95, 98, 2000, Windows ME, or Windows NT 4.0
* |6 MB RAM

* 800 x 600 |6-bit color SVGA video display

* At least 60 MB of available hard-disk space is recommended (typical installation).
You'll need 80 MB to install Card Studio and the Event Planner; | 10 MB is
required to install Card Studio, the Event Planner, and the Adobe Acrobat
Reader.

* Four-speed CD-ROM drive
* A mouse

* An Internet connection if you want to e-mail cards or access the Hallmark Card
Studio Web site

Installing Card Studio

The Installation program creates a folder for Card Studio, copies files to your hard
disk, and enables you to select program options. It also creates a program group
titled Sierra, containing a folder called Hallmark Comedy Card Studio. The Card
Studio folder contains icons for Card Studio programs.

The installation program starts automatically if AutoPlay is enabled on your comput-
er. We've included alternate instructions for installing Card Studio if AutoPlay is dis-
abled.
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To install Hallmark Comedy Card Studio:

| Insert the Card Studio Application CD into the CD-ROM drive. The Card
Studio Installation program starts.

2 Follow the instructions on the screen. When the installation is complete, you can
begin using Card Studio.

To install Hallmark Comedy Card Studio (AutoPlay is disabled):

| Insert the Card Studio Application CD into the CD-ROM drive.
2 Click the Start button at the lower left of the screen.
3 Click Run.
4

Inside the Run box next to the word “Open,” type X\SETUP (where X is the
drive letter for the CD-ROM drive; it's usually D or E), and press ENTER or
click OK.

5 Follow the instructions on the screen. When the installation is complete, you can
begin using Card Studio.

Registering Card Studio

Register Card Studio to get technical support and hear about upgrades and addi-
tional Sierra programs. Use your Internet connection to register on the World
Wide Web. The installation program prompts you to register near the end of the
installation process.

Starting Card Studio

» Card Studio’s installation enables you to place a Card Studio icon on the desk-
top. If you created an icon during installation, double-click the icon. Or, click the
Start button on the Windows taskbar, point to Programs, point to Sierra, point
to Hallmark Comedy Card Studio, and click Comedy Card Studio.
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Note: The first time you start Card Studio, you'll be given the opportunity to config-
ure Kid Lock and run the Card Studio tutorial.

Running the Card Studio Tutorial

After you start Card Studio, the Getting Started tutorial screen automatically
appears. You can run the Getting Started tutorial at any time to learn the basics of
working with the Card Studio program. The tutorial teaches you to select and cus-
tomize cards, work with the Art Studio, and create other, non-card products. Click
Don't Ask Me Again if you don't want to see the tutorial screen at startup. You can
select this option with either Yes or No.

» Click Yes to run a brief, introductory tutorial introducing Card Studio’s features.
» Click No to begin using Card Studio without running the tutorial.

* To run the tutorial after the Card Studio program is started, select Getting
Started Tutorial from the Help menu.

Using Card Studio Buttons and Getting tHelp

Once you start Card Studio and begin using Card Studio selection and work areas,
you'll see icons at the bottom of the screen. These icons help you navigate around
Card Studio and access Event Planner.

Button Name Description
'ﬂ\”““”l Home Used to return to the main Activity screen.
*: Back Used to return to the previous screen.
Back )

Event Planner  Used to start Event Planner and to access the
Event Planner Calendar and Address Book.

::i) Help Used to show Help topics for the displayed screen.
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Card Studio provides three kinds of on-screen help.

* Hints appear automatically in the box at the bottom of each screen as you
move the mouse pointer over buttons and other objects.

* Select Help Contents from the Help menu to see the online Help table of con-
tents.

* Click the Help icon at the bottom of any screen, press F| at any screen, or
select Card Studio Help from the Help menu to see Help topics for that screen.

Uusing Card Studio Menus

At the top of the workspace is the menu bar, which displays all of the available
menus within the workspace. Menu commands are dimmed when unavailable.

The following table describes the Card Studio menus.

Menu Name Description

File Used to open, save, and print your Card Studio projects. Also
used to exit Card Studio.

Edit Use to cut, copy, and paste selected objects in the Art Studio.
You can also undo actions you've made by mistake.

Cards Use to choose card categories and select e-cards from the
Hallmark e-cards Web site.

Object Used to select, move, layer, align, and flip objects in the
Art Studio.

Other Products  Use to select non-card products such as labels, postcards,
and stationery.

Hallmark Papers  Use to select Hallmark Papers products and templates.

Tools Used to find a card, go to the Art Studio, access the Event
Planner, change Kid Lock settings, and select card collections
to view.

Help Used to start the Card Studio online Help system and display

the table of contents or index. You can also start the Card
Studio tutorial using Help menu options.
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To select a menu option, click the menu, and then select an option. Or, use the key-
board combinations listed below to select a menu and move through the menu

options.

Menu Command Shortcut Keys

Activate menu bar ALT key

Move across menu bar  RIGHT and LEFT ARROWS
File menu ALT+F

Edit menu ALT+E

Cards menu ALT+C

Object menu ALT+B

Other Products menu  ALT+O
Hallmark Papers menu  ALT+P
Tools menu ALT+T
Help menu ALT+H
Move through Options  UP and DOWN ARROWS

Closing Card Studio

To close Card Studio:

* On the File menu, click Quit. Card Studio closes, and you are returned to the
Windows desktop. Card Studio warns you if you have unsaved changes.
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Card Studio Basics

Card Studio is a powerful tool that puts you in control of designing cards (including
invitations and announcements), envelopes, stickers, labels, stationery, and more.
Although Card Studio has extensive creativity tools, it also offers a simple, quick way
to produce a card.

This section gives you instructions for very basic card design—ijust choose a card and
modify the text. If you're anxious to start designing on your own, you may just want
to glance through this section to get familiar with Card Studio functions and then
move to “Using the Art Studio.”

Fo//r Lasy Steps

Step |: Choose a card.

From the Activity screen, you can select a card type or use Find a Card. Both are
easy. Selecting a card is just like being in your favorite greeting card department;
you simply look under an occasion for a card. Using Find a Card lets you quickly
define the occasion and category for the card you are seeking.

* Step 2: Personalize your card.

Card Studio enables you to edit text so that the card says exactly what you
want.

» Step 3: Print your card and envelope or e-mail the card.
* Step 4 Fold your card.

Folding instructions are described later in this guide. You can also view instruc-
tions on your computer screen.

Step 1: Choosing a Card

Although Card Studio runs on a computer, it is designed to provide as many card
choices as your favorite card shop. Because these cards are electronic, it's easy to
change a card to suit your specific needs. For example, you can select a birthday
card for the picture, but change the text to an anniversary greeting.
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Choosing a Card

| From the Activity screen, click a card occasion or type such as Birthdays.
Categories appear for the card type.

2 Click the category that best fits your needs. If you selected birthday cards, for
example, you might select Friends or Family. (Click the More Choices arrow to
see additional card options.) The Card Choices screen opens, showing up to four
cards at a time. (If there is only one category for the occasion, Card Studio takes
you automatically to the Card Choices screen.)

Note: If you are selecting a Hallmark Papers card, select Hallmark Papers, select
Cards, select a card template, and then click OK. The template is placed in the Art
Studio so you can personalize the card.

Browsing Through the Cards

Once you select an occasion and a category for the card, you can view all the avail-
able cards. The number of cards that are displayed depends on the options you
choose.

As you look through the cards, remember that it's easy to change “brother” to “sis-
ter” or “good luck” to “happy anniversary.” With Card Studio, you always get a card
that's just right.

| Browse through the cards until you find one you want to read. Click the More
Cards arrow to display additional cards.

2 Click the card you like to select it. The Preview screen appears to show a larger
view of your card choice.
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Selecting a Message

Once you've selected a card, an enlarged version displays on your screen. Now you
can read the entire message in context with the design. Messages are generally on
the cover and inside right (or inside bottom, if the card is horizontal). Some cards
also have text on the inside left (or inside top). All panels containing text are listed in
the Let's Look At box. The back of the card contains the back page art.

l|
Lais Look =
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Click the panels that appear in the Let's Look At box to read the message. (Only
the panels containing text or art appear in the box.)

If you want to view more related cards, click the More Cards arrow to read
through the rest of the cards for your selection.

Note: You can also use the Back button in the button bar to return to the Card
Choices screen so you can see additional choices.

Once you have chosen the card you want to send, you are ready to personalize
it. For instructions, see “Step 2: Personalizing Your Card.”

Choosing a Card with Find a Card

Another way to choose a card is with Find a Card. Find a Card enables you to com-
bine and display several groups of cards at once, saving you time by allowing you to
select a broader selection of messages and designs at one time.

Click Find a Card on the main Activity screen. Or, from the Tools menu, click
Find A Card. The Find a Card screen opens, displaying occasions and categories.

Choose the category for the card. The right side of the page changes to display
card groups for the category. Use the scroll arrow to see more card groups.

Choose all the groups that fit your needs.
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4 Click OK. Cards that fit the category and groups you specified are displayed on
the Card Choices screen.

5 Click on a card to select it.

6 For instructions on choosing your message, see "“Selecting a Message.” Then, see
“Step 2: Personalizing Your Card.”

Step 2: Personalizing Your Card

One of Card Studio’'s most exciting features is its ability to customize every card.
What kinds of changes can you make!?

» Change names (“Sue” to “Phyllis”)

* Change relationships (“mother” to “aunt”)

* Change occasions (“birthday” to “Mother’s Day")

* Delete all the text and write your own message
Note: A few cards have text embedded in the front page graphics. This text cannot
be changed.

There are two ways to choose text for editing. You can use the Change Text but-
ton or move directly to the text. Both are easy!

Using the Change Text Button

| From the Preview screen, display the panel with the text you want to change.
2 Click Change Text.

3 Move the pointer over the card. The mouse pointer changes to indicate you can
edit the text. Also, an insertion point appears at the beginning of the text.
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Moving Directly to the Text

You don't have to click Change Text. Once you display the panel with the text you
want to change, just move the mouse pointer to the text area and click. The mouse
pointer changes to an insertion point.

After the insertion point is displayed, you can use the keyboard arrow keys to move
around the text.

Changing Text
Once you position your insertion point in the text area, you have three choices for
editing the text:

*  Press DELETE (or BACKSPACE, depending on the cursor position) on the key-
board until all the letters you don't want are deleted, then type the new letters.

* Hold down SHIFT while pressing the RIGHT ARROW or LEFT ARROW keys
until the text you want to change is highlighted, then type the new letters.

*  While holding down the left mouse button, drag the pointer across the letters
you want to change, then type the new letters.

Note: In the Card Studio Preview screen, the text frame does not automatically
change size when you add to the text in the frame. To enlarge the text frame, open
the Art Studio and resize the frame.

Getting a Closer View

Depending on the size and resolution of your screen, you may want to magnify the
card. To see the detail of a design or text, use the Zoom button.

| Click Zoom In. The label on the button changes to Zoom Out.

2 If the part of the card you want to view isn't on the screen, click the arrows to
move the view.

3 Click Zoom QOut to return to a normal view.

Note: Sometimes thin lines, apostrophes, and commas are hard to see. You can
zoom in for a more accurate representation, or you can print a draft.
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Choosing and Personalizing Your Back Page Art

Normally, a greeting card has art on the back panel. Card Studio back page art can
be edited to include your name. It's just as easy to personalize back page art as it is
to personalize your card!

| Click Back to view the back panel.

2 If you want a blank back panel, click the left Back Page Art arrow until a blank
panel appears.

3 If the back page art you want can be personalized, click Change Text and add
the words to make it uniquely yours.

Note: You're able to edit back page art and other card elements more exten-
sively using Art Studio. Just click Art Studio from the Preview screen.

Reviewing Vour Card

Many Card Studio products contain sample names, places, and other information.

After you've personalized your card, be sure to check for the following before you

print:

* Have you changed all the personalized examples to fit your situation?

*  When you changed names, ages, and so forth, did you change other related
words in the card? Example: If you changed “Alec” to “Melanie” on a child’s

birthday card, be sure you changed any male pronouns like “he” and “him" to
“she” and “her.”

* If you wrote your own message, are your spelling and punctuation correct?! Card
Studio makes designing a card easy; however, it cannot detect spelling or gram-
matical errors.
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Lditing Tips
With Card Studio cards, you can change a few words or the entire message. Card
Studio’s writers have a few suggestions to help you create that special card for that
special person.

PERSONALIZE

Use the person’s name in the title, message, or closing—or in all three places.
You'll often be given a name example, so be sure to change the name to the
one you'd like to use. Don't forget to add your own name, especially in the clos-
ing.

CUSTOMIZE

You can also personalize your message by including something unique about the

person. Added mention of a nickname, hobby, or favorite things can be easily
worked into a particular message, and can make that special card “extra special.”

EXPLORE

Browsing through other occasions, categories, or recipients may spark a new
idea or produce a message that's almost perfect. A few word changes can turn
an anniversary card into a wedding for the one you love, or a friendship card
into the perfect message for your mother.

EXPERIMENT

Try writing your own message! Think about your relationship with the person
who'll be receiving the card. Write down your thoughts. Sometimes saying it
straight from your heart, in your own words, can be an especially meaningful
way to make the perfect card. Look through the designs and lettering fonts for
those that seem to best match the tone of your message. Pick your favorite and
replace the preplanned message with your own creation.

Saving Your Card

After you've selected and personalized a card, you can save it in its customized form
for reuse.

To save your card:

From the File menu, click Save. The Save File dialog box appears.

2 Type a description for the file. Or, if you want to replace an existing file, click a

filename.
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3 Click Save to create the product file in the default location. Or, select a different
drive or folder for the file and then click Save.

Step 3: Printing Your Card

After you select and personalize a card, you are ready to print. (For information on
e-mailing your card, see “E-mailing Your Cards.”)

Note: If you are printing a double-sided card for the first time, you'll be asked a
series of questions about feeding the paper through your printer.

| From the Card Preview screen, click Print. Or, from the File menu, click Print.
The Print dialog box appears. (If you have made changes to the card that
haven't been saved, you'll be prompted to save them at this time.)
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2 Select your printer.

3 Select the paper source. (For a single-fold card or heavy paper, you may need to
select Manual Feed.)

4 Select the paper size.

* Many cards will default to a new “classic” card size, exclusive to Card Studio
titles. This size is more like an authentic greeting card.

Note: Single-fold cards can be printed in either “classic” or half-fold size.

* If you've selected a card from the Hallmark Papers templates, that template is
listed and selected by default.

(O]

For changes using the Windows Printer Setup dialog box, click Set Up.
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6 Click a different format if you want to change the print format. Card Studio’s
artists designed each card for a specific format that is automatically selected. If
you change the format, you may want to print a draft to see if you like the way
the card is resized. (To print a single-fold card on one sheet of paper, see
“Printing on Both Sides of the Paper.” If you want to print a self-mailer, see the
following section, “Printing a Self-Mailer.”)

7 Use the arrow buttons to adjust the number of copies (I to 99).

Place the paper in the printer. If you are printing a single-fold card using two dif-
ferent types of paper, the heavier paper (front and back panels) should go
through the printer first.

9 When you are ready, click Print Now.

If you are printing a single-fold, one-page card for the first time, you'll be asked a
series of questions to help Card Studio correctly print this type of card with
your printer. See “Printing a Single-Fold, One-Page Card for the First Time" for
more information.

Note: You can also print an envelope for the card from this screen.

Printing a Self-Mailer
With half-fold and quarter-fold cards, you can create a self-mailer. Your return

address and the address of your recipient prints on the back panel instead of the
back page art.

| From the Preview screen, click Print. Or, from the File menu, click Print. The
Print dialog box appears.

Select your printer.
Select the paper source.
Select the paper size.

For changes using the Windows Printer Setup dialog box, click Set Up.

o U AN W N

Use the arrows to adjust the number of copies (I to 99) you'd like to create for
each recipient. The default is |; however, Card Studio will print as many copies
as you select.

7 Click Self Mailer. The Self-Mailer dialog box appears.
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8 Type your name and address in the return address area. Once you type the
return address, Card Studio remembers the information and you won't need to
type it again.

9 Click the name of the person or family in your Address Book to whom you
want to send the card. Select as many names as you want—a great help for
party invitations—and Card Studio prints a card for each name.

Note: You must set up recipients in the Address Book before you can select
them here. For information about setting up contacts in the Address Book, see
“Working with Individuals.”

|0 Place the paper in the printer and when you are ready, click Print Now. Follow
the instructions on the screen.

The U.S. Postal Service has restrictions on self-mailers. Do not use a lightweight
paper. Seal the mailer along the long edge (one centered tab for a quarter-fold card,
two tabs about an inch from each end for a single-fold card). Contact your local
post office if you have additional questions.

Printing on Both Sides of the Paper

You can print your cards either on two sheets of paper and paste them together, or
you can print on both sides of a sheet of paper.

When you print a single-fold card, you have the option to print on one or two
sheets of paper. After the first side is printed, Card Studio pauses to let you turn the
paper over before printing the other side. If you do not want to print on the other
side of the paper, you can print on a second sheet.

| When you finish your card, click Print. Or, from the File menu, click Print. The
Print dialog box appears.

2 Select the printing options you want. (For information on Print options, see
“Step 3: Printing Your Card.”)

3 Click Print Now. (The first time you print, you are asked for information about
how paper is fed into your printer, and then Card Studio prints test pages.
When you print the double-sided card, Card Studio displays an animation show-
ing you how to correctly flip the paper. If you use more than one printer, you
must provide this information for each printer. If you need to run the print test
again, you can do so after printing.)
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4 After the first side prints, turn the paper over and continue printing. Watch the
animation to see how to flip the paper.

Printing a Single-Fold, One-Page Card for the First Time

When you print a single-fold, one-page card for the first time, Card Studio asks a
few questions about how your printer works. Card Studio uses the answers to guide
you when printing a two-sided document.

Note: This process must be repeated for each additional printer.

| Is the paper fed through the top or front of your printer? Select the correct
option for your printer, and then click OK.

2 When feeding a sheet through your printer, the paper is aligned to the left, cen-
ter, or right edge of the tray or guide. Select the correct option for your printer,
and then click OK. Card Studio prints one page with an X and one with an
arrow.

3 Examine the printed pages print-side up. Select: “X" Page On Top or “X" Page
On Bottom, and then click OK.

4 Insert the page with the arrow back into the printer so that the arrow points to
the printer and the printed side is face up, and then click OK. Card Studio prints
two more arrows on the page.

5 Examine the printed page, and then select the example that corresponds to the
printed page. Click OK. Card Studio is now set up for printing double-sided
cards with the selected printer.

6 Click OK to exit printer configuration.

Why Is There a White Margin Around the Printed Card?

Most printers don't print to the edge of the paper. The area the printer leaves blank
is called the nonprintable area. The nonprintable area varies, depending on the
printer you are using. When you print, Card Studio centers the graphics and text on
each panel inside the printable area. Therefore, you don't have to worry about leav-
ing room for the nonprintable area when designing your card.
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Since printers don't print all the way to the edge of the paper, labels may also have
a white margin. Some labels on a sheet may extend into the printer's margin, the
nonprintable area. When the printer's nonprintable area overlaps a label, Card
Studio scales the graphics and text on the label so that nothing is truncated by the
nonprintable area. Therefore, some labels may print smaller than others. This hap-
pens most commonly on the last column of labels.

Step 4: Folding Your Card

The final size of your card depends on the paper size you choose and what sizes are
supported by your printer. Make sure you allow ample time for the ink to dry
before folding to avoid smearing the ink.

Quarter-Fold

A quarter-fold card is folded into four sections. Each section will be 4.25 by 5.5 inch-
es if 8.5-by- | I-inch paper is used. This style prints on one side of the paper and can
be used either horizontally or vertically.

| For either a vertical or horizontal card, fold the paper in half across the middle
with the printing on the outside.

2 Fold the paper in half again.

Single-Fold One Sheet

A single-fold card is folded in half and folds to 5.5 by 8.5 inches if 8.5-by-1 |-inch
paper is used. It can be used either horizontally or vertically.

Note: You can also use the following instructions if you've printed a card in the
Hallmark “classic” size.

| Hold the paper with the front and back panels of the card facing away from you.

2 Fold the paper in half across the middle.
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Single-Fold Two Sheets

A single-fold card is folded in half and folds to 5.5 by 8.5 inches if 8.5-by-1 |-inch
paper is used. It can be used either horizontally or vertically. Use an insert with
lighter weight paper for the inside page.

| Fold the heavier paper (cover) in half across the middle with the printing on the
outside.

2 Fold the lighter paper (the insert page) in half across the middle with the printing
on the inside, then trim one-eighth inch from the three cut edges.

3 Place a few dots of glue (or double-sided tape) on the front panel of the insert.
Do not glue the back panel.

4 Place the insert inside the cover and smooth the glued side.
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Working with
- Mon-Card Products

Calendars

Use Card Studio to create a personalized family calendar to hang on your refrigera-
tor. Print a calendar for one month or the entire year. All the information you
record in the Event Planner calendar can be printed on these calendars.

Choosing a Calendar
| On the main Activity screen, click Other Products.

2 On the Other Products screen, select Calendars.

3 Click the style of artwork you want on your calendar. Look in the Preview area
to view the selected artwork style.
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4 Select either a I-month or |2-month calendar. If you choose | Month, click the
Choose Graphic arrow below the preview to select the graphic you want to
print on the calendar, and use the arrows to select the month and vyear. If you
choose 12 Month, use the arrows to select the year. You can preview each
month by clicking the View Graphics arrows below the preview.

5 Select Show Event Planner Notes if you want your notes from the Event Planner
calendar to appear on the calendar.
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6 Select Show Mini Previous/Next Month if you want small calendars of the previ-
ous and next months to appear on the calendar.

7 Click OK. You can now add text to any day on the calendar.

Click Change Text. The insertion point appears on the first text field. Click any
day to place the insertion point on the day.

Printing Calendars

| From the Calendar Preview screen, click Print. Or, from the File menu, click
Print. The Print dialog box appears.
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Select your printer.

Select the paper source.

For changes using the Windows Printer Setup dialog box, click Set Up.

2
3
4 Select the paper size.
5
6

Select to print either all 12 months or use the arrows to choose the months to
print. (This step not available if printing only one month.)

7 Use the arrows to select the number of copies to print.
8 Click Print Now.
Lnvelopes

Envelopes are available as a separate product type in Hallmark Comedy Card Studio.
(To learn about selecting and personalizing an envelope, see “Choosing an
Envelope.”)
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You can also print envelopes from the print dialog box when you are printing a
card. To learn about printing envelopes for your cards, see “Printing an Envelope
from the Card Printing Screen.”

Choosing an Envelope
| On the main Activity screen, click Other Products.

2 On the Other Products screen, select Envelopes. The Envelopes screen opens.

Click the type of envelope on which you want to print.

4 Click an envelope design name. A preview appears when you click a design
name.

5 Once you select the design you want to use, click OK. The Envelope Preview
screen opens. You can browse through the other designs for the selected enve-
lope type by clicking the More Envelopes arrow.
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Addressing an Envelope

You can address envelopes one of three ways. You can type an address directly
onto the envelope, select one person from your address list, or insert replaceable
fields to print envelopes that each contain a different address.

* To type an address on the envelope, either click Change Text or click the text.
An insertion point appears so you can type the address.

* To use a name from the Address Book, click Use One Name From the Address
Book, then click the name you want. If the person’s address has been entered in
the Address Book, the address appears on the envelope automatically.

* To print multiple envelopes for several people, click Use Replaceable Fields For
Mail Merge. A list of field names appears. Suggested field names may also appear
on the envelope. Click the name of the information, such as First Name, you
want to print on the envelope. Delete unwanted fields from the envelope face.
When you print the envelopes, you get to choose from the Address Book
which names are printed on the envelope. Then, the fields are replaced with the
actual information from your Address Book.

Printing Envelopes

There are two ways to print envelopes: |) you can print a plain envelope from the
Print dialog box when printing a card, or 2) you can print one of the envelope
designs from the Envelope Preview screen. If doing a mail merge, you can select the
addresses you want on the envelopes. However, before you print, you must provide
some information about how envelopes are fed into your printer.

Sexting Your Printer for Envelopes

The screen for configuring your printer for envelopes appears automatically the first
time you choose Print Now from the Print dialog box or the first time you choose
Print from the Envelope Preview screen. After you enter these settings, Card Studio
remembers the printer configuration.

Of course, if you have multiple printers, you'll have to enter settings for each printer.
You'll also have to enter new settings if you add a new printer.
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You may want to have your printer manual at hand before starting this section.

If this is not the first time you have printed envelopes, click Configure Envelope
while the Print Envelope screen is still displayed. The Printing An Envelope dialog
box appears.

If you are not familiar with the way your printer handles envelopes, you may
want to get your printer manual before clicking OK. Refer to your printer manu-
al for information on completing the remaining options.

Select the way envelopes are fed into your printer, and click OK.

Select the side of the envelope that is face up when it is inserted into the print-
er. Symbols on your printer should indicate whether the address or flap side is
up. Sometimes the flap-down position is indicated by dotted lines for the flap,
while a flap-up position is indicated by solid lines for the flap. When you have
made your selection, click OK.

Select the position of the envelope when it is inserted in the printer. If the enve-
lope is inserted lengthwise, make sure you know if the flap is on the left or right
side. When you have made your selection, click OK.

Select the way the envelope is aligned in the paper tray. When you have made
your selection, click OK. A message is displayed, informing you that the envelope
printing configuration is complete.

Click OK. The Print Envelope dialog box appears. You are ready to finish making
your selections for printing the envelope.

Printing an Envelope from the Card Printing Screen

Card Studio makes it easy to print envelopes. You can type in a name and address,
or you can select a contact from the Address Book. You can even select multiple
names from the Address Book, and Card Studio will print an envelope for each
name you choose.

Note: If this is the first time you are printing envelopes, you have to configure
your printer before actually printing. For more information, see “Setting Your
Printer for Envelopes.”
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| After you have printed your card and while the Print screen is still displayed,
click Print Envelope. The Print Envelope dialog box appears.
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2 Select your printer. If you select a printer that has not been configured for
envelopes, you'll automatically go to the Printing An Envelope Introduction
screen. For instructions on configuring your printer for envelopes, see “Setting
Your Printer for Envelopes.”

Select the envelope source.

4 Select the envelope size. If you select Custom, an area for entering the envelope
measurements appears.

5 If you are printing a custom-size envelope, type the height and width of the
envelope in inches.

6 Click Print One Envelope to print a single envelope, or click Print Many
Envelopes to print more than one. The Address Envelope dialog box appears.
The insertion point is in the Return Address box in the upper-left corner.

7 If this is the first time you are printing an envelope or if the return address is
wrong, type the correct return address in the Return Address box in the upper-
left corner of the envelope. After you type this information, Card Studio remem-
bers it.

8 If you are printing a single envelope, either click in the Address box and type a
name or select a name from your Address Book list. If you are printing multiple
envelopes, click all the names that need envelopes. (You cannot type in any
names if you are printing multiple envelopes.)

Note: You can change the typeface for the envelope. The typeface you select
will be applied to all the text on the envelope.

9 When you have entered/selected all names for envelopes, click Print Now.
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Printing an Envelope from the Envelope Preview Screen

When printing from the Envelope Preview screen, the Print options you see are dif-
ferent depending on whether or not you're using replaceable fields.

Note: If this is the first time you are printing envelopes, you have to configure
your printer before actually printing. For information, see “Setting Your Printer
for Envelopes.”

| From the Envelope Preview screen, click Print. Or, from the File menu, click
Print. The Print Envelope dialog box appears.
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2 Select your printer. (If you select a printer that has not been configured for
envelopes, you'll automatically go to the Printing An Envelope Introduction
screen. For instructions on configuring your printer for envelopes, see “Setting
Your Printer for Envelopes.”)

Select the envelope source.

4 Select the envelope size. If you select Custom, an area for entering the envelope
measurements appears.

5 If you are printing a custom-size envelope, type the height and width of the
envelope in inches.

For changes using the Windows Printer Setup dialog box, click Set Up.

If you used replaceable fields on the envelope, click Address Book to select
names from your Address Book for a mail merge, then click Done.

Note: If you do not have entries in your Address Book, a message appears.
8 Click Print Now.
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Labels

Card Studio contains a variety of label designs. Select from a list of label types and
then select the design for that label.

Your Address Book displays on the Label Preview screens so that you can choose a
person from your address list. If you want to print labels for more than one person,
you can insert replaceable fields for a mail merge.

Labels that are specially designed for use with Hallmark Papers are also included in
Card Studio programs. When you select a Hallmark Papers label, the preprinted
area is displayed as a nonprintable layer. Use the nonprintable layer to place text or
graphical elements exactly where you want in relation to the designs on the
preprinted Hallmark Paper.

Choosing a Label

| On the main Activity screen, click Other Products.
2 On the Other Products screen, select Labels.

The Labels dialog box appears.

ma o]

3 Click the type of label you want to print.

4 Click a design name. A preview appears when you click a design name.
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5 Once you select the label you want to use, click OK. The Label Preview screen
opens.

Choosing a Label from Hallmark Papers

| On the main Activity screen, click Hallmark Papers.
2 On the Hallmark Papers screen, select Labels.

The Labels dialog box appears.

Hallwark Papers

3 Click the label you want to use. The label is marked Selected.
4 Click OK. The Art Studio screen opens.

Note: This product is designed for use with preprinted Hallmark Papers. When
you select a label, the preprinted area is displayed as a nonprintable layer. Use
the nonprintable layer to place text or graphical elements exactly where you
want in relation to the designs on the preprinted Hallmark Paper. When you are
done creating your label, you can print on the Hallmark Papers you've pur-
chased.
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Addressing a Label

You can address labels one of three ways. You can type an address directly onto the
label, select one person from your Address Book, or use replaceable fields to print
labels that each contain a different address.

* To type an address onto the label, either click Change Text or click the text. An
insertion point appears so that you can type the address or other text.

* To use a name from the Address Book, click Use One Name From the Address
Book, then click the name you want. If the person’s address has been entered in
the Address Book, the address automatically appears on the label.

* To print multiple labels for several people, click Use Replaceable Fields For Mail
Merge. A list of field names appears. Suggested field names may also appear on
the label. Click the name of the information, such as First Name, you want to
print on the label. Delete unwanted fields from the label face. When you print
the labels, you get to choose from the Address Book which names are printed

on the label. Then, the fields are replaced with the actual information from your
Address Book.

Printing Labels

When you print labels, you have the option to print one or multiple labels. You can
also indicate on which label you want to begin printing, so you don't waste those
half-used sheets of labels. When you select the Print option from the Label Preview
screen, the Print dialog box appears.
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| Select your printer.

2 Select the paper source.
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For changes using the Windows Printer Setup dialog box, click Set Up.

4 If you're using replaceable fields on the labels, click Address Book to select names
from your Address Book, and when you've finished, click Done.

5 Use the arrows to select the row and column on which to begin printing. Then,
select the Fill To End Of Page option to print all labels on the remainder of the
page, or use the arrows to select the number of labels to print.

6 When you are ready, click Print Now.

Note: Sometimes label sheets aren't exactly the same size, and the printer may
feed the sheets a little differently each time. If the design starts printing off the
label, use the arrows to adjust the horizontal and vertical label alignment.

Newsletters

Card Studio contains a variety of newsletter formats. Use newsletters to write to
family and friends or use as a flyer. Use the special Hallmark Papers newsletters to
give your documents a special touch!

Note: You can use the Newsletter instructions for Invitations products selected
from the Hallmark Papers menu.

Choosing a Newsletter From Hallmark Papers

| On the main Activity screen, click Hallmark Papers.

2 On the Hallmark Papers screen, select Newsletters.

3 Click the newsletter template you want to use. The template is marked Selected.
4 Click OK. The Art Studio screen opens.

Note: This product is designed for use with preprinted Hallmark Papers. When
you select a newsletter, the preprinted area is displayed as a nonprintable layer.
Use the nonprintable layer to place text or graphical elements exactly where you
want in relation to the designs on the preprinted Hallmark Paper. When you are
done creating your newsletter, you can print on the Hallmark Papers you've pur-
chased.
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Printing a Newsletter

| From the Art Studio screen, click Print. Or, from the File menu, click Print. The
Print dialog box appears.
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2 Select your printer.

3 Select the paper source.

4 Select the paper size. (If you are using a Hallmark Papers template, the first
paper size is the selected template.)

5 For changes using the Windows Printer Setup dialog box, click Set Up.

6 Use the arrows to select the number of copies to print.

7 Click Print Now.

Postcards

Sometimes, nothing can be more ideal than a postcard. Whether you need to notify
friends and associates of a new address, an upcoming graduation or engagement, or
for any other purpose or event, a postcard can be the perfect “short and sweet”
way to say it. Hallmark Comedy Card Studio includes predesigned postcard products
and postcards that are specially designed for use with Hallmark Papers.

Choosing a Postcard
| On the main Activity screen, click Other Products.

2 On the Other Products screen, select Postcards.
3 Click the type of postcard you want to create.
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4 Click a Postcard design. Look in the Preview area to see the selected design.

5 Once you have chosen a design, click OK. You can now personalize your selec-
tion with information from your Address Book or by clicking the text on the
postcard. If you want to view additional designs, click the More Postcards arrows.

6 Inthe Let's Look At box, click Back to create the back of the postcard.

Choosing a Postcard From Hallmark Papers

| On the main Activity screen, click Hallmark Papers.
2 On the Hallmark Papers screen, select Postcards.

3 Click the postcard you want to use. The postcard is marked Selected.

Hallmark Papers

4 Click OK. The Art Studio screen opens.

to Contents 37 to Index



Hallmark Card Studio™ | Working with Non-Card Products

Note: This product is designed for use with preprinted Hallmark Papers. When
you select a postcard, the preprinted area is displayed as a nonprintable layer.
Use the nonprintable layer to place text or graphical elements exactly where you
want in relation to the designs on the preprinted Hallmark Paper. When you are
done creating your postcard, you can print on the Hallmark Papers you've pur-
chased.

Addressing Your Postcard

You can address postcards in one of three ways. You can type an address directly on
the postcard, select one person from your Address Book, or insert replaceable fields
to print the same postcard with different addresses.

* To type an address on the postcard, either click Change Text or click the text.
A text cursor appears so you can type the address or other text.

* To use a name from the Address Book, click Use One Name From the Address
Book, and click the name you want. If the person’s address has been entered in
the Address Book, the address appears on the postcard automatically.

* To print multiple postcards for several people, click Use Replaceable Fields For
Mail Merge. A list of field names appears. Suggested field names may also appear
on the card. Click the name of the information, such as First Name, you want to
print on the postcard. Delete unwanted fields from the postcard face. When you
print the postcards, you get to choose from the Address Book which names are
printed on the postcard. Then, the fields are replaced with the actual information
from your Address Book.

Printing Postcards

| From the Postcard Preview screen, click Print. Or, from the File menu, click Print.
The Print dialog box appears.
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Select your printer.

Select the paper source.

Select the paper type.

For changes using the Windows Printer Setup dialog box, click Set Up.
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If you're using replaceable fields, click Address Book to select names from your
Address Book, and click Done. Then, use the arrows to specify the number of
times to repeat the address list. The default is |; however, Card Studio will print
as many copies as you select for each recipient.

Note: The Address Book will not be displayed unless you are using replaceable
fields. Click the Back button to return to the previous screen if you want to
select replaceable fields.

7 Click Print Now. (The first time you print, you are asked for information about
how paper is fed into your printer, and then Card Studio prints a test page.
When you print the double-sided postcard, Card Studio displays an animation
showing you how to correctly flip the paper. If you use more than one printer,
you must provide this information for each printer. If you need to run the print
test again, you can do so after printing.)

Stationery

Use the Stationery option to select from a variety of stationery designs. Complete
stationery sets, which include stationery, envelopes and cards with the same theme,
are also available.
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Choosing Stationery
| On the main Activity screen, click Other Products.

2 On the Other Products screen, select Stationery.

3 Click the description for the design you want to use. The design is shown in the
Preview area.
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4 Click OK. Your selected design is placed on the Preview screen. You're ready to
personalize your selection. You can browse through the other designs by clicking
the More Stationery arrows.

Note: If the stationery you select has a matching envelope, a Matching Envelope
button appears on the Preview screen.

Printing Stationery
| From the Stationery Preview screen, click Print. Or, from the File menu, click
Print.
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2 Select your printer.

3 Select the paper source.

4 Select the paper size.

5 For changes using the Windows Printer Setup dialog box, click Set Up.
6 Use the arrows to enter the number of copies you'd like to print.

7 Click Print Now.

Stickers

With Hallmark Comedy Card Studio, you can create and print stickers. Not only are
stickers perfect for envelopes, packages, and a variety of social and professional occa-
sions, making them “to order” is an activity the whole family can enjoy.

Choosing Stickers
| On the main Activity screen, click Other Products.

2 On the Other Products screen, select Stickers.

3 Click the Avery number or shape of sticker you want to create. Look in the
Preview area to view the selected format.

| | .
s il
— e

(1

ol

— =
e =
Sl
e ———
§ 11 Ay 111 P Reaarge

—

4 Click OK.

Fill in the stickers by clicking a sticker on the sticker page, and clicking a graphic
until the sheet is full. Or, click Copy To All if you want to copy the same design
to the entire page.
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6 If a sticker contains text you'd like to change, select the sticker on the sticker
page and click Change Text. Click Change Text again when you are done.

Note: If you want to clear all stickers and start over, click Clear Selected, and
then click Copy To All.

Printing Stickers

Note: The sticker selection screen lists both the Avery model number for the
sticker and the sticker shape. Use the Avery sticker number when shopping for
the correct sticker to print.

| From the Sticker Preview screen, click Print. Or, from the File menu, click Print.
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Select your printer.
Select the paper source.
For changes using the Windows Printer Setup dialog box, click Set Up.

Use the arrows to enter the number of pages you'd like to print.

2
3
4
5
6

Use the arrows to adjust the horizontal and vertical sticker alignment.
Sometimes sticker sheets aren’t exactly the same size, and the printer may feed
the sheets a little differently each time. If the graphic starts printing off the stick-
er, adjust the sticker alignment.

7 Click Print Now.
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Printing 7ips

Card Studio is compatible with most Windows-compatible printers. Make sure that
you follow the care and maintenance instructions for your printer. Follow your
printer manufacturer’s advice about the type of ink and cartridges to use. If there
are problems with the color or ink, such as uneven appearance or colors that do
not match the screen colors, refer to the printer manual for troubleshooting and
technical support.

To preserve the original colors of your creation, store your card away from mois-
ture and light.

Using an Ink-jet Printer

Ink-jet printers print by spraying tiny dots of ink on the paper. The printer accepts
information from the computer about what to print for a few lines of dots at a time.
The speed of printing may vary, depending on the speed of your computer, the
amount of memory in your computer, virtual memory settings, and whether or not
you are using print spooling. See your printer manual for suggestions.

Ink requires time to dry. The amount of time varies depending on the type of ink,
the absorbency of the paper, the density of the color, and the humidity. In general,
avoid touching the ink.

Using a Laser Printer

Laser printers print by applying the toner to the paper under heat. The printer
“builds” the entire page to be printed in its memory before it begins printing. Be
patient; it may take a while for the computer to print and the laser printer to “com-
pose” your creation. (If the Form Feed light on your printer is on or the online light
is blinking, that usually means everything is okay and the printer is just thinking.)

If your printer doesn't have enough memory, you may get a “Memory Overflow”
message on the printer or computer screen, or only part of a page may print. See
your printer manual for help.
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Choosing the Paper

Choosing the right paper is a key factor in making your Card Studio card look pro-
fessional. The thickness, or weight, of the paper is important. If the paper is too thin,
the ink may bleed through or make it so wet that it appears wrinkled. If the paper is
too thick, it may not feed through the printer well or it may not fold smoothly and

crisply.

Your printer manual will indicate what weight of paper can be used in the printer.
Look in the Specifications section and under Paper in the index of your printer man-
ual for this information. Generally, 60-, 70-, or 80-pound paper gives the best results.

If you are printing a single-fold card on two sheets, we recommend you use a heav-
ler paper for the cover and a lighter paper for the insert page with the inside mes-
sage.

Let the experts at Hallmark help you create beautiful and professional-looking cards.
Your creativity, combined with our wide variety of images and messages, printed on
just the right card stock, will make any project a success. Hallmark offers white and
ivory card stock, pre-scored for your convenience. Half-fold, quarter-fold, and classic
stock in varying weights make your home printing projects look and feel professional.
Matching sized envelopes with an embossed Hallmark logo add the perfect finishing
touch.

Feeding the Paper

Typical laser and copier bond papers are fine for printing. However, to give your
cards a more professional look, you may want to use higher-quality papers.

Often, higher-quality paper is a different weight than the paper you normally use in
your printer. If it is very different, you may need to change one or more of the fol-
lowing settings:

* A manual-feed/auto-feed setting in the Printer Setup in Windows.
* A manual-feed/auto-feed setting on your printer.

* Mechanical switches on your printer.

Consult your printer manual for exact instructions.

If you are going to print your card on both sides of a sheet of paper, make sure you
understand how to place the already-printed side of the paper in the paper tray
when you print the second side. Consider printing a test copy onto plain paper first.
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Feeding Envelopes

To print envelopes properly, Card Studio must know exactly how envelopes are fed
into your printer. Please use your printer manual to verify the information needed
for Card Studio envelope configuration. In addition, you may need to change the
mechanical switches on your printer for envelopes. This information will also be
found in your printer manual.

E-mailing Your Cards

Once you select and personalize that perfect card, you can e-mail it to the recipient.
When that special person receives the card, he or she can view the card, page by
page, on the screen. There are two ways to e-mail your card: e-mail your card using
a mail package that supports Microsoft MAPI, or save a file that you can attach to
your e-mail message later.

Note: Recipients using non-Windows operating systems may not be able to
open e-mailed cards.

E-mailing Using MAP/

Microsoft Mail Applications Programming Interface (MAPI) is a way for applications
to send e-mail without needing to know how the e-mail is sent. If you have an e-
mail package that supports MAPI, you can use this option.

| From the Card Editing screen, click E-malil. The E-mail dialog box appears.
2 Click the arrow to choose a background for your e-mail.

Click Preview to preview the card you are sending. Use the arrows on the
Preview screen to view the card panels. Click Close to exit the preview.

4 Optionally, select Warn Me Before Sending Large Cards (larger than | MB).

Click E-mail. Your e-mail program opens with e-card.exe attached to the mes-
sage.

6 Send the message using your e-mail program. Depending on the recipient’s e-
mail package, he or she can either double-click the attachment, or save the
attachment on his or her hard disk and open the attachment to view the card.
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Saving the Card as a File That Can Be E-mailed Later

Use this method to save the card as a file to send later, or to e-mail a card using an
e-mail service that is not MAPI compliant.

| From the Card Editing screen, click E-mail. The E-mail dialog box appears.

2 Click the arrow to choose a background for your e-mail.

3 Click Preview to preview the card you are sending. Use the arrows on the
Preview screen to view the card panels. Click Close to exit the preview.

4 Optionally, select Warn Me Before Sending Large Cards (larger than | MB).
Click Save. The Save E-mail Attachment dialog box appears.

6 Click OK to create the attachment in the default location with the default name.
Or, select a different drive, folder, or name for the file, and then click OK. The
file is saved and you can attach it to an e-mail message using your e-mail pro-
gram.

Note: Some Internet service providers (ISPs) do not allow you to send files that
are more than | MB in size. If your ISP has this restriction and you plan to send

animated cards or cards with large, complicated graphics, always select Warn Me
Before Sending Large Card.

L-Cards

You can use Card Studio to access a variety of fun and interesting multimedia cards.
These cards contain animation and music. E-Cards are found on the Hallmark
Comedy Card Studio Web site, so you'll need an active connection to the Internet
when you select this option.

Choosing an Animated Card

| From the Cards menu, click E-Cards. Your default Web browser starts, and the
Hallmark Comedy Card Studio Web site opens.

2 Use the Card Studio Web site to select, personalize, and send a multimedia
card.
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Using Are Studio

Art Studio features art and text tools for working with cards and other items. These
tools enable you to do whatever you want (size, move, color, and so forth) with the
different parts of your design. Use the Art Studio to customize the product designs
included with the Card Studio products, or to begin creating products from a blank
layout. All product types are available as blanks in the Art Studio.

Art Studio has a book with clip art and photographs that you can insert. Or, if you
prefer, you can use the Drawing tools to make your own designs and then write
your own special words. You can also import your own photographs and graphics.
Card Studio gives you many options!

It's easy to use Art Studio to work from scratch or to embellish an existing design.
Experiment in Art Studio until you're satisfied that you have the perfect layout! The
Art Studio screen is shown below.

Creative Tips from the Pros

People communicating with other people—that's what sending cards is all about.
The messages may be serious or funny, but a card is the perfect way to show that
you're thinking about someone and sharing something special.

Part of the fun of sending cards can be making your own from scratch. The following
are some tips from the professionals.
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1. Start with the message.

Think about your relationship with the person and your reason for creating the card.
Jot down all your ideas. Decide what's most important for you to communicate.
Focus on that one thought. Write it in your own words.

If you get stuck, do what the professionals do. Look in other places for inspiration. In
Art Studio, click Insert Greeting to browse through greetings or click the Art Book
icon for some idea starters. Think about popular songs, commercials, TV shows, or
movies to get some ideas. Both current events and memories from the past can

provide interesting ideas that you can develop. Just remember to say it in your own
way.

Now edit your message. That just means take another look at what you wrote. Ask
yourself the following:

* Does it get your idea across?
* Have you found the right tone (funny or sentimental)?
* Are your grammar, punctuation, and spelling correct?

* Have you personalized your message! Remember to include the person's name.

* Did you add your name?

2. Add a design that illustrates your message.

Browse through the artwork and clip art in the Art Book for a design you like. Or,
create your own design with the Drawing tools in Art Studio.

Here are some things to think about when choosing a design. Match the art to the
tone of your card. Make sure there's enough space for all your text. Experiment
with different layouts. Choose a type style and color that enhances the tone of your
words and complements the design.

Now check your card:

* Do all the elements (message, art, colors, type, and so forth) work well togeth-
er?

* Does it communicate your feelings?

And, remember, have fun! Making your own card is a creative way to reach out to
someone special—in your own unique style!
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Developing Your Cards in Are Studio

To create a card in Art Studio, follow these steps:

| Add text by selecting a predefined message from the Greetings screen, or write
your own message.

2 Select one or more designs from the Art Book.

3 Add dlip art, import your own photographs and artwork, or draw shapes using
the Art Studio’s drawing tools.

4 Edit the designs, clip art, images, and shapes.
5 Edit the text to personalize it (if it came from the Greetings screen).
6 Print or e-malil your card.

See the following sections for help with each of these tasks.

Operiing the Art Studio from the Main Activity Screen

| Click Art Studio on the Card Studio main Activity screen. Or, from the Tools
menu, click Art Studio. The Document Types dialog box appears.

2 Click the type of document you want to create, such as
Cards/Invitations/Announcements or Postcards.

3 Click the format for the document. (Horizontal format means a Landscape ori-
entation. Vertical format means a Portrait orientation.)

* If you choose Cards/Invitations/Announcements, you must specify a fold type.

* If you choose Envelopes, Labels, or Stickers, you must choose the type of
envelope or sheet instead of the format.

* If you choose Calendars, select the calendar format; then you must select
calendar options, such as | month or |2 months, and month and year.

4 Click OK. The front panel of a blank document is placed on the drawing board
in Art Studio.

Opening the Are Studio from the Preview Screen

Click Art Studio while the card or other product is in the Preview screen. The
selected card is placed on the drawing board in Art Studio.
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Note: All Hallmark Paper products are automatically placed in the Art Studio when
the project is selected.

Working with Texe

There are three ways to bring text into Art Studio: you may choose a message from
the greetings list, write a message of your own, or bring in a complete card from
one of the Card Studio collections. Wherever your message comes from, once you
have decided on the final wording of your text, you can do some imaginative
enhancements in Art Studio.

Here are some different approaches to try:

* Choose a special color for your text. Picking a color tone that appears in your
design can enhance the custom look of your card. Make sure that the shade you
select is readable. (Consider outlining pastel colors in black for better readabili-
ty.)

* Emphasize a name, key word, or phrase by choosing a different font, larger size,
contrasting color, outlining, or underlining. Or, experiment with a combination of
special effects, but remember to keep it simple and match the tone of your mes-
sage.

* Make the first letter of your message stand out by enlarging and changing color
and font.

* Add a new slant to your message by rotating some words or changing their
height on the page. Just remember to keep the message readable.

* Try putting your text on top of the art. This works best on simple designs with
softer colors.

Using the Greetings List
The Greetings List contains sentiments, plus some additional verses. Use the
Greetings List to browse and select from a variety of professionally written greetings.

| In the Insert box, click Greeting.
2 Click the occasion you want.

3 Click the category or person that defines who or what this card is for.
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4 Click the Up and Down arrows at the right side of the greeting area to view the
entire greeting.

5 Click the Right and Left arrows below the greeting area to view additional greet-
Ings.
When you find the greeting you want, click it. The message is selected.

7 Click Add To Project. The greeting is marked Pasted.

Click Close. The window closes, and the greeting is placed on the drawing
board. If you are working on a card, all of the text is placed on the appropriate
panel. Use the card panel selection box to view the entire greeting.

Creating Tex¢

Although Card Studio contains an outstanding selection of verses for your cards,
sometimes you may want to write your own words to express your personal feel-
ings.

Before you begin working with text, it's important to know that text is contained

within an area known as a text box. The text box can also be referred to as an
object.

Before you start typing your text, you must first draw a text box. After you have
drawn the text box and typed your words, you can always move or resize the box.

| Click the panel on which you want to work.
2 Click the Edit tab. The Text tools appear.

3 Click New Text.
4

Move the pointer over the card. The pointer changes to a small box with letters
and an arrow to show you can create a text box.

5 To draw a text box of a specific size, place the text-box pointer at the location
for the upper-left corner. Hold down the left mouse button and drag the point-
er to the lower-right corner. Release the mouse button. Or, place the text-box
pointer anywhere on the drawing board and click. A text box and cursor
appear. The upper-left corner of the box is located at the point where you
clicked and fills the rest of the card panel. This technique is useful if you want to
create a text box the size of the entire panel.
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6 Type your text. The text wraps automatically within the box. To move the cur-
sor within the text box, use the SPACEBAR and arrow keys. Each time you
want a new line, press ENTER.

7 Use the Text tools to change text color, size, font, and/or alignment. (For more
information, see “The Text Tools.”) You may want to wait until you have placed
all the text and art on your design.

8 When you finish working with the text, click Stop Edit. The text box is selected.

Lditing 7ext
You can change text entered or pasted from the greeting area, text brought into
Art Studio with a predesigned card, or text typed directly into Art Studio.

| If necessary, click the Edit tab. The Text tools appear.
2 Click Edit Text. The text pointer appears at the beginning of the text box.

Note: If you have more than one text box on the card panel, you may need to
click Edit Text again until the cursor is in the text box you want to edit.

3 Move the pointer over the card on the drawing board. The mouse pointer
changes to tell you that you can edit text.

4 Once you position your cursor in the text area, you have three choices for edit-
ing the text: |) Press DELETE until all the letters you don't want are deleted,
then type the new letters; 2) hold down SHIFT while pressing the RIGHT
ARROW until the text you want to change is selected, then type the new let-
ters; or 3) while holding down the left mouse button, drag the pointer across
the letters you want to change, then type the new letters.

5 Click Stop Edit to quit editing.

The Text 700/s

The Text tools display when you click the Edit tab. The Text tools enable you to
control the appearance of text. You can use the tools to set attributes either before
you create the text or after the text is on the card.

Remember that text is contained within a text box and that this text box can also
be referred to as an object. When you are sizing text, you can change the size of
the text only or change both the text and its box.
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Displaying the Text Tools and Selecting Text
Before you use the Text tools, you must select the text you want to change.

To select all the text in a text box:

* Move the pointer over the text and click. The handles on the text box appear.
All the text within the box is selected; however, it is not highlighted. Any
changes you make will be applied to all the text.

You can also select a text box with the Object buttons. For more information, see
“Selecting Objects.”

To select part of the text in a text box:
| If the Text tools are not displayed, click the Edit tab.
2 Click Edit Text. The text cursor appears at the beginning of the text box.

Note: If you have more than one text box on the current card panel, you may
need to click Edit Text again until the cursor is in the text box you want to edit.

3 Move the mouse pointer into the text box. Click and drag to select the text you
want to change. The selected text is highlighted. Any changes you make will be
applied to the selected text.

Changing Font

| Select the text you want to work with, and click Typeface. The Typefaces win-
dow opens.

== .
J_y/lf./—_""]":.l":;i_"

TimaScrbhlig
TomeBerTikA el
TRIFTAM RECULAR
Tubiiler Megular
Fuime|Fuk

UNICHREN REGINLAR

UIRV AR T

HIRWAL T Bodid

LW ALcaidin TE sl

LWIRWAIon-Tig

URWAntinguaTEXIBol

URWEgyptionna Thlac
@ LEWImperial T

to Contents 53 to Index



2 Click the arrows to scroll the list. Or, type the first letter of the typeface name
to go to that location within the list.

Click the name of the font.

4 Click Apply. The Typeface window closes. Any selected text is changed immedi-
ately. If no text is selected, the new font is applied as you type new text.

Changing Text Color

You can use two different colors for the same text—one color for the inside of the
letters and one for the outline. Most of the time the inside and outline colors are the
same, but using different colors can add flair to messages.

| Select the text you want to work with, and click Text Color. The Text Color
box opens. The box with the X in it indicates no color (transparent). As you
make your choices, the words “Sample Text" change to let you see how the col-
ors look.
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2 Click the inside color. If necessary, click the arrows to scroll through the list.

Optional: click the outline color. If necessary, click the arrows to scroll through
the list.

4 If you chose outline colors, click the Up and Down arrows in the Outline Size
box to adjust the width of the outline color.

5 When you are satisfied with the way your choices look in the Sample Text box,
click Apply.
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Adding Replaceable Fields for a Mail Merge

When you open a label, envelope, or postcard in Art Studio, you can add replace-
able fields for a mail merge. Select the fields you want to use, then choose names
from the Address Book when you print. Use the following procedure to replace
text in the open label or envelope with replaceable fields for a mail merge.

| Click Edit Text.

2 Place the insertion point where you want to insert the replaceable field or select
the text you want to replace with a field name.

Click Mail Merge. The Mail Merge dialog box appears.
4 Select the field names you want to insert.

Click Done. The field names are inserted on the page. Remember to add appro-
priate punctuation and spaces between fields.

Note: Merge Fields is only available on Labels, Envelopes and Postcards.

Changing Text Size
There are several options for changing text size. Remember that text is contained

within a text box. Therefore, you can change the size of the text, the size of the
text box, or the size of both the text and its box.

| Select the text you want to change. (For more information, see “Displaying the
Text Tools and Selecting Text.")

2 In the Text Size box, click the big arrow for larger letters or the little arrow for
smaller letters.

The selected text is changed. The text box size does not change.

Changing Both Text and Text Box Size

If you want to change the size of both the text and the text box, use the Select
Object and Next Object buttons to select the text box. (For more information, see
“Selecting Objects.”) Then you can either use the arrows for the object Size option
or you can drag the object handles. To see the object Size options, click the Layer
tab. For detailed instructions on object sizing, see “Sizing an Object.”
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Changing Text Box Size Only

You can change just the size of the text box without changing the size of the text.
However, if you make the box too small, some text will not display.

| If the Text tools are not displayed, click the Edit tab.
2 Click Edit Text, and select the text object you want to change.

3 Move the pointer to the lower-right corner of the text box. The pointer
changes to a four-headed arrow.

4 Drag the corner inward to make the box smaller or drag outward to make the
box larger.

The text box size changes. The type size inside the box does not change.

Note: If you are creating new text and the box you've drawn is too small, make
sure that you select Edit Text and use its special pointer to make the text box
larger.

If you have resized your text and the letters are so large that all the words do not
appear within the text box, you must use this method to make the text box larger.

Aligning 7Text
Within a text box, text can be aligned to the left, center, or right. You can also ver-
tically align the text to either top, middle, or bottom of the text box.

| If the Text tools are not displayed, click Edit.

2 Click Edit Text, and select the text object you want to change.

3 Click Left, Center, or Right. The alignment is applied to all text in the box.

4 Click Top, Middle, or Bottom. The alignment is applied to all text in the box.
Note: Most greeting card text is centered.

Edit Calendar 7Too/

The Edit Calendar tool enables you to change the attributes of a calendar open in
Art Studio. This tool is only available when the date grid of a calendar is selected. Be
sure that you have the calendar selected, not the background.
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The attributes you can change using the Edit Calendar tool are fill/edge and text
color, text size, and font. You can select the area of the calendar you want to
change, such as the mini calendar outline, the note text, or year header.

| Select the calendar.

2 Click the Edit Calendar tool. The Edit Calendar dialog box appears.
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Select the section of the calendar you want to change.

4 Select the font, text size, fill/edge color, or text color, as appropriate. The
options change depending on the section of the calendar you chose to change.
Use the arrows to scroll through the fonts and colors. The changes appear in the
preview.

5 Click OK when the calendar looks like you want.

Working with Are

Use Art Studio to manipulate and enhance designs for your custom cards. Designs
for the Art Studio can come from several places: a complete card chosen from Card
Studio collection, your own artwork or scanned photographs, or a design found in
the Art Book. The Art Book contains a wide variety of clip art images, as well as an
assortment of other artwork for all occasions.

The tools in Art Studio provide a variety of ways to have fun designing cards. You
will probably want to experiment with all the tools, but here are some suggestions
to get you started:

» Try different approaches to the same design. Use the object handles to change
the size or shape for a unique look.
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+ Copy and paste an image multiple times to create a special effect or a border
design.

* Experiment with scale and position. Enlarge, reduce, or rotate an image for a
new look.

* Crop a design for the best effect or to eliminate unwanted elements.

» Combine several different images by pasting them on top of each other. Then,
using the Art Studio tools, choose the top image and resize it so that you can
see the image beneath it. Continue to resize each image until you can see them
all, then move them around as needed. You can combine designs from different
sources, such as clip art, other Card Studio designs, and your own artwork and
photographs.

Tips for Using Clip Art from the Are Book

The Art Book contains a variety of images. If you have a black and white printer, clip
art may print better than some other designs. Adding color later with felt-tip pens
can produce the effect you want. With a color printer, you can change or add color
to most clip art images. You can manipulate clip art just like other Card Studio art.

Using the Are Book for Clip Art and Photos
| In the Insert box, click Art.
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2 Click the People, Places, or Things tab. The Art Book opens to the index for the
section you select.
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3 In the What Type Of Image Are You Looking For box, click the topic you want.
If necessary, use the scroll arrows to see more topics. The designs for that topic
appear.

Note: The index topics for the People, Places, or Things tabs are different from
one another, but the page design is the same.

Use the Left and Right scroll arrows to see additional designs.
When you find the design you want, click it. The design is selected.
Click Add To Project. The design is marked Pasted.

Click Close Book. The book closes, and the design is placed on the current card
panel.

~N o o b

Importing Your Own Photos and Graphics

There's nothing more personal than using a photograph or an original creation. Many
times, that's the only design element you'll want to use. You may want to consider
adding a scanned photograph to a graduation announcement or your company logo
to a retirement announcement.

Card Studio automatically recognizes BMP, DIB, FPX| PG, PCD (Kodak Photo CD),
PCX, PNG, PSD, TGA, WMF, and noncompressed TIF file formats. If your artwork is
in a format Card Studio does not recognize, you may still be able to use it. Display
the artwork in the software used to create it. Copy the artwork to the Clipboard.
Then, switch to Art Studio in Card Studio and click Paste. The artwork from the
Clipboard is placed on the drawing board.

| In the Insert box, click Art.
2 Click the Import tab. The Art Book opens to the Import section.

Select the drive and folder containing your file. If you are using a photo CD,
remember to place the CD-ROM in the drive, and select the drive (usually D or
E).

4 Select the file.
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5 If you want to display a preview of the file, select the Check To See Preview
check box.
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Click Add To Project. The preview is marked Pasted.

7 Click Close Book. The book closes, and your artwork is pasted on the current
card panel.

Inserting Photos in Art Studio

You can import a photo directly from a scanner or digital camera, from a file, or
from the Clipboard.

| In the Art Studio Insert box, click Photo.

2 Click the scanner or digital camera device you want to use, then click Acquire to
add a photo directly from the scanner or camera. Your scanner or digital camera
software takes over until the photo is added to the card.

The Drawing 700/s

You can use the Drawing tools to create interesting shapes and lines. How about a
dozen green trees on the inside of a Christmas card? Once you have drawn an
object, it's easy to move, copy, or resize it. You can also apply color to shapes.

Displaying the Drawing 700/s
| Click the Draw tab. The Shape tools and Color tools appear.

2 You're ready to draw a shape or apply color.
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Drawing a Square or Rectangle

|
2

After displaying the Drawing tools, click the Square/Rectangle tool.

Move the mouse pointer to the drawing board, and click where you want one
corner. Do not release the mouse button.

Drag to the opposite corner, then release the mouse button.
To center a rectangle from a specific point, hold SHIFT while dragging.

To create a square, hold CTRL while dragging.

Drawing a Circle or Llljpse

After displaying the Drawing tools, click the Circle/Ellipse tool.

2 Move the mouse pointer to the drawing board, and click where you want one
side. Do not release the mouse button.

3 Drag to the opposite side, and release the mouse button.
To center an ellipse from a specific point, hold SHIFT while dragging.
To create a circle, hold CTRL while dragging.

Drawing a Heart

| After displaying the Drawing tools, click the Heart tool.

2 Move the mouse pointer to the drawing board, and click where you want an
upper edge. Do not release the mouse button.

3 Drag to the opposite edge and release the mouse button.
To center a heart from a specific point, hold SHIFT while dragging.
To create a proportional heart, hold CTRL while dragging.

Drawing a Hexagon

| After displaying the Drawing tools, click the Hexagon tool.

2 Move the mouse pointer to the drawing board, and click where you want the
hexagon center. Do not release the mouse button.

3 Drag to one corner and release the mouse button.
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Drawing a Triangle
| After displaying the Drawing tools, click the Triangle tool.

2 Move the mouse pointer to the drawing board, and click where you want the
triangle center. Do not release the mouse button.

3 Drag to one corner and release the mouse button.

Drawing a Star
| After displaying the Drawing tools, click the Star tool.

2 Move the mouse pointer to the drawing board, and click where you want the
star center.

Drag to a point and release the mouse button.

4 Move the pointer toward the center or away until the star is shaped the way
you want, and click.

Drawing a Straight Line
| After displaying the Drawing tools, click the Straight Line tool.

2 Move the mouse pointer to the drawing board, and click where you want the
line to begin. Do not release the mouse button.

3 Drag the pointer until the line is the length you want and release the mouse
button.

Drawing a Freehand Line (Doodling)

Freehand line drawing is another way to say doodling.
| After displaying the Drawing tools, click the Freehand tool.

2 Move the mouse pointer to the drawing board, and click where you want the
line to begin. Do not release the mouse button.

Start doodling by moving the pointer in any direction you want.

4 When the line is finished, release the mouse button.
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Coloring an Object

Shapes are much more interesting with color. For example, if you have multiple
shapes on your design, you might make each one a different color or variation of
the same color.

You can also use color if you want to cover something in the center of a design.
Create a white box over the part you want to eliminate. This works when you want
to put a different design or words in the center of a border.

Even though color is an option, never forget that black and white can create a strik-
ing image. Or, take a hint from the advertising industry, and create a black-and-white
design with just one spot of color.

Objects in Art Studio have two types of color: inside and outline. You'll enjoy finding
your own new ways to use color!

If you are coloring an existing object, move the pointer over the object, and
click.

The handles on the object box appear.

Note: You can also select an object with the Object buttons. For more informa-
tion, see “Selecting Objects.”

If necessary, click the Draw tab.

Click the Color tool. The Object Color palette opens. The box containing the X
indicates no color (transparent). Check the Sample box to see how the current
settings look.

Click the inside color. If necessary, click the arrows to scroll the list.
Click the outline color. If necessary, click the arrows to scroll the list.

If you chose different inside and outline colors, click the Outline Size arrows to
adjust the width of the outline color.

When you are satisfied with the way your choices look in the Preview box, click
Apply. The color of any selected object is changed immediately. If no object is
selected, the new color is applied to the new objects you create.
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The Object Buttons

Each text box and piece of artwork you place on your card is an independent
object that you can manipulate in Art Studio. Card Studio includes the following
buttons.

| wiea | Use Select Object to define the object with which you want to work. This
S button is available if there is at least one object on the drawing board.

button is available if there are multiple objects on the drawing board and an

Use Next Object to define the object with which you want to work. This
%)
object is selected.

F”“‘] Use Erase to delete a selected object.

w Use Undo when you want to cancel the action (move, paste, color, size,
erase) you just did.

@ Use Copy when you want to place a duplicate of a selected object on the
| Clipboard.

D Use Paste when you want to move a duplicated object from the Clipboard
to the drawing board.

Buttons are located at the left of the drawing board (for vertical-format designs) or
above the drawing board (for horizontal-format designs). The buttons appear only
when they can be used.

Note: The Cut, Copy, Paste, and Delete options also appear as commands on
the Edit menu. Select Object and Next Object also appear as commands on the
Object menu. You can perform actions using the menus or shortcut keys if you
prefer.

Selecting Objects

You can select an object using the object buttons, the mouse, or menu commands.

When an object is selected, it is framed by a box with square buttons, or handles,
on the corners and sides. There is also a handle directly above the center of the
object (indicated by a circle) that is used for rotating.

to Contents 64 to Index



Selecting with the Object buttons:
| Click Select Object. An object on the drawing board is selected.
2 If this is not the object you want, click Next Object until the correct object is

selected. (Next Obiject is not available if there is only one object on the drawing
board.)

Selecting with the mouse:

| To select an object with the mouse, simply click the object once.

2 To select more than one object at a time (so you can move them together or
apply color to all of them at once, for example), hold down SHIFT as you select
each object. Or, click above and to the left of the objects you want to select,
then drag the mouse pointer to draw a bounding box around the objects.
Release the mouse button. The objects are all selected. (Be sure to include all
parts of the objects in the bounding box or an object may be left out.)

Selecting with menu commands:

| From the Object menu, click Select Object. An object on the drawing board is
selected.

2 If this is not the object you want, click Next Object from the Object menu until
the correct object is selected.

Moving an Object

You can move an object with the Move tools or with the mouse.

| Select the object you want to move. A box with handles appears around the
selected object.

2 If the object Move arrows are not visible on the right side of the screen, click
the Layer tab.

3 Click the Move arrows to position the object. Or, click the object and use the
mouse to drag the object to a new position.
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Sizing an Object
You can make an object larger or smaller with the Move tools.

| Select the object you want to size. A box with handles appears around the
selected object.

2 If the object Move tools are not visible, click the Layer tab.

3 In the Size box, click the big or little size arrow to make the object larger or
smaller. Or, click one of the object handles and drag to resize the object. Refer
to the chart below to decide which handle to use.

If you click And perform The result is

this handle Lhis action
Corner Drag The object resizes proportionally.
Corner Drag while The object resizes freely.
holding SHIFT
Side (left, right, Drag The object resizes non-proportionally (only the
top, bottom) width or height changes).

Experiment with the different sizing techniques until you find the one that best
matches your needs.

Skewing an Object

You can skew or slant an object using the object handles.

| Select the object you want to skew. A box with handles appears around the
selected object.

2 Press SHIFT and move the pointer to a side, top, or bottom (but not corner)
handle. The pointer changes to a skew pointer.

3 Drag the handle while holding SHIFT.
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Rotating an Object

You can rotate an object around its center point. The center point of an object is
indicated by a circle. The rotate handle is a square directly above the center point,
unless the object has already been rotated.

You may want to rotate an object when you have a vertical design on a horizontal
format. Rotating objects can also be used to scatter small design elements (hearts,
stars, flowers, and so forth) all over the card. Just rotate each design to a different
angle. Have fun playing with this feature!

| Select the object you want to rotate. A box with handles appears around the
selected object.

2 If the object Move tools are not visible, click the Layer tab.

3 Click the left (counterclockwise) or right (clockwise) Rotate tool to rotate the
object. Or, move the pointer over the rotate handle for the selected object until
the rotate cursor (two curved arrows forming a circle) appears. Drag the rotate
handle to the position you want. If you want to return an object to an upright
orientation, just turn the rotate handle to a straight up position.

Cropping an Object

Cropping means cutting off a small section. You can crop vertically and horizontally.
You may want to consider cropping when there is only a small part of the design
you want. Sometimes, if a design is small, you may need to enlarge it, and crop the
parts you don't want or that don't fit on your card. If you are removing a border,
you may have to crop 30 or more times before it is all cut off. Try all the options
until your art is just right! (Only photos and clip art can be cropped.)

Note: You can only see the cropping arrows when the Move tools are displayed
at the lower-right portion of the Art Studio screen.

| Select the object you want to crop. A box with handles appears around the
selected object.

2 If the object cropping tools are not visible, click the Layer tab. The cropping
arrows appear with the other Move tools at the lower-right portion of the Art
Studio screen.
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3 In either the Vertical or Horizontal crop box, click the arrow for the side of the
design you want to crop (cut off). A very small section is removed. Another
arrow appears in the Crop box. This arrow enables you to undo the crop if you
take off too much.

4 Continue cropping until the design is the right size.

Note: If you rotate the photo and use the Crop tools, the top/bottom and
left/right arrows crop as if the photo had not been rotated. For example, if you
rotate a photo so that the sides are now the top and bottom, the left/right
arrows crop what was originally the left and right sides.

Copying an Object

You can make duplicates of objects using the Windows Clipboard. Copying is useful
if you want a repeating design. You can make your own borders and designs by
copying design elements around the edge of your card or by placing them randomly
on your card.

| Select the object you want to copy. A box with handles appears around the
selected object.

2 Click Copy. Or, from the Edit menu, click Copy. Or, press CTRL+C. The object
is copied to the Clipboard. (You cannot see what is on the Clipboard.) The
Paste button appears to indicate there is something on the Clipboard to paste.

3 Click Paste. Or, from the Edit menu, click Paste. Or, press CTRL+V. A copy of
the object is pasted on the current panel.

4 Move the new object to the new position.

Repeat pasting and moving as many times as necessary if you are creating a
repeating design.

Erasing (Deleting) an Object

You can delete an object with the Erase button, with the DELETE key on the key-
board, or using menu commands.

| Select the object you want to delete. A box with handles appears around the
selected object.

2 Click Erase. Or, press DELETE on the keyboard. Or, from the Edit menu, click
Delete. The object is deleted.
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Undoing a Change

You can reverse the last edit or change you made to an object in Art Studio by
using the Undo command. For example, you can undo applying color, resizing an
object, moving text, and so forth.

* Immediately after completing an action that you want to cancel, click Undo. Or,
from the Edit menu, click Undo. Your most recent change is undone.

Zoom 700/8

To see the detail of a design or text, use the Zoom tools. Three levels of zoom are
available.

| If the Zoom tools are not visible, click the Layer tab.

2 In the Zoom box, click the magnification option you want. Your view of the card
is magnified.

3 If the part of the card you want isn't displayed on the screen, click the scroll
arrows to move the view.

4 If the view of the card isn't magnified to the degree you want, click one of the
other magnifying arrows.

5 Click Off to return to a full view.
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Advanced Techniques

You can access advanced commands for working with objects by selecting the object
and then clicking the right mouse button or selecting the option from the Object

menu. A menu opens containing the Order, Arrange, Align To Page, and Flip com-
mands.

Changing the space between letters, or kerning, is an advanced text feature that is
done using the keyboard. For more information on kerning, see “Kerning Text.”

Changing Object Order

Sometimes you may want to have one object on top of another. For example, you
might want the words in a text box placed on top of a piece of artwork. The follow-
ing table lists the options for object order.

Object Order Option Description

Move To Front Moves the selected object to the front or top.

Move To Back Moves the selected object to the bottom or back.

Move Forward One Moves the selected object up one level toward the front
or top.

Move Back One Moves the selected object down one level toward the

bottom or back.

Arranging Objects

The Arrange command enables you to group objects together to help organize your
work. Grouping gathers separate objects together and makes it easier to select
objects and makes it possible to manipulate several objects at once. Connecting cre-

ates a single object out of the selected objects. Card Studio has the following
Arrange commands.
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Arrange
Command Description

Group Use when you want to create a collection of individual objects.
Grouping does not change an object’s appearance.

Ungroup Breaks objects apart from the group. Any changes that were made
while the objects were grouped are kept when they are
ungrouped.

Connect Connects the endpoints of objects.

If a single object is selected, draws a line connecting the endpoints
of the object. You can use this command when you draw a free-
hand object and you want to close two ends together.

If multiple objects are selected, draws lines connecting the end-
points of the objects to each other.

(You cannot connect text, grouped objects, or bitmaps.)

Disconnect Returns one or more objects to their original, disconnected state.

Aligning Objects
The Align To Page command enables you to change the alignment of objects on the
drawing board in relation to the page.

* Horizontal Center—Aligns objects equally spaced horizontally on the page.
* Vertical Center—Aligns objects equally spaced vertically on the page.
* Both—Aligns objects both horizontally and vertically on the page.

Flipping Objects
The Flip command enables you to flip selected objects horizontally or vertically.
* Horizontally—TFlips selected objects horizontally, reversing the image left to right.

* Vertically—Flips selected objects vertically, reversing the image top to bottom.
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Kerning Text

Changing the space between characters, or kerning, is normally used to eliminate
white space between characters or to separate characters that are too close togeth-
er (for example, To, Wa, Yo, and so forth).

| If the Text tools are not displayed, click Edit.

2 Select the text you want to change, and click Edit Text.

3 Move the insertion point between the characters you want to kern.
4

Press and hold CTRL+ALT and press the LEFT ARROW to move the second
character closer to the first. Or, press and hold CTRL+ALT and press the
RIGHT ARROW to move the second character farther from the first.

Starting Over

You can always discard the work you've done and start over at the Document Type
screen. If you decide to start over in Card Studio, you'll always have the option of
changing your mind and keeping your work.

| In Art Studio, click Start With Blank. The Notice box asks if you'd like to save
your work.

2 Click No to discard your work. The Document Types screen opens. You are
ready to choose a document format and start a new creation.

Saving Your Work

You can save your work at any time. Make a habit of saving regularly in case you get
interrupted or have a power failure.

| In Art Studio, click the Open/Save icon, and then click Save File. Or, from the
File menu, click Save.

2 Type a description for the file. Or, if you want to replace an existing file, click a
file name.

3 Click Save to create the product file in the default location. Or, select a different
drive or folder for the file, and click Save.
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Working with Your Existing Files

Once you have saved your creations, it's easy to open the files again. At some point,
you may also want to delete some of your existing files. You can access your saved
work from either the Activity screen or from within Art Studio.

Opening Your Saved Work

You can open any creation you've saved.

| If you are in Art Studio, click the Open/Save icon. Or, if you are in the Activity
screen, click the Saved Work button. Or, from the File menu, click Open. The
File Options box opens. The options you see vary depending on which method
you used to open your work.

2 Type or click the name of the file you want to open. Or, select a different drive
or folder and then click the name of the file.

3 Click Open File.

Deleting Your Saved Work

After a period of time, you may want to delete some of your saved files.

| If you are in Art Studio, click the Open/Save icon. Or, if you are in the Activity
screen, click the Saved Work button. Or, from the File menu, click Open. The
File Options box opens.

2 Type or click the name of the file you want to delete. Or, select a different drive
or folder, and click the name of the file.

Click Delete File. A message asking if you're sure appears.

4 Click Yes.
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Controlling Content

Some Card Studio content may not be suitable for all users. The ability to control

the content you see is set with the Kid Lock feature. You have several options for
Kid Lock:

* Turn Kid Lock on or off each time you use Card Studio.

*  Specify if Kid Lock is on or off when Card Studio is started.

* Set or change a password for using Kid Lock.

Turning Kid Lock On or Off
You can turn Kid Lock on or off each time you use Card Studio.

| On the Tools menu, click Kid Lock. The Kid Lock screen opens.
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2 The current status is shown on the left side of the screen. Click On if you want
Kid Lock turned on right now (some content will not be available), or, click Off if
you want Kid Lock turned off right now (all content will be available).

3 If you are finished with Kid Lock and don’t want to change the Kid Lock startup
status or password, click OK.
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Setting the Default Kid Lock Status

| With the Kid Lock screen displayed, click the option you want when Card
Studio starts:

* Click On to have Kid Lock turned on (some content will not be available).
» Click Off to have Kid Lock turned off (all content will be available).

2 If you don't want to set a password, click OK.

Sexting a Password for Kid Lock

You can set a password for controlling access to Kid Lock.

| With the Kid Lock screen displayed, click Change Password. The Change
Password dialog box appears.

2 Type up to 100 characters for your password. You can use any combination of
letters and numbers. Passwords are not case-sensitive.

3 After you have typed your password, click OK. The Notice box warns you that
you must reinstall Card Studio if you forget the Kid Lock password.

4 Click OK. The Kid Lock screen opens.
Click OK. The main Activity screen opens.

Using the Kid Lock Password

If you have set a password, you must use it to change Kid Lock’s current or startup
status.

| On the Tools menu, click Kid Lock. The Kid Lock Prompt screen opens.
2 Type the correct password.

Click OK. The Kid Lock screen opens. For instructions, see “Setting the Default
Kid Lock Status.”

Note: If you ever forget your Kid Lock password, you must reinstall Card Studio
in order to delete it.
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Lvent Planner

Event Planner has three powerful features that help you track upcoming events and
maintain personal information for family and friends—Calendar, Address Book, and
Reminders. From now on, you have an easy way to keep up with birthdays and
anniversaries for all the special people in your life.

You can also easily record all your social events and weekly commitments. As you
enter your important events and special occasions, you can choose to get reminders
beforehand so you'll always be prepared for parties, meetings, or other important
events.

Special features of Event Planner include the following:

» Calendar—The Calendar easily lets you enter notes for special one-time events
(like your 20th year high school reunion), as well as regularly scheduled activities
(soccer practice every Saturday morning). Normally, the Calendar is not used to
enter birthday or anniversary dates.

* Address Book—Naturally, the Address Book is used to enter mailing information
(there's even space for an e-mail address) and phone numbers. It is also used to
enter birthday and anniversary dates. When you enter birthday and anniversary
years in the Address Book, the birthday and anniversary numbers are calculated
and displayed on your Calendar. Like notes entered on the Calendar, you can
choose to be reminded of birthdays and anniversaries before the occasion.

* Reminders—Any time you enter a note on your Calendar or a birthday or
anniversary in your Address Book, you can choose to be reminded before the
day of the event. You can get reminders for | to 30 days before an event.
Reminders display automatically in a special box every day. Reminders are also
listed in a special place on the Calendar.

Moving Between Card Studio and Lvent Planner

It's easy to move back and forth between Card Studio and Event Planner using the
convenient buttons at the bottom of your screen or menu commands.
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Go from Card Studio to
Event Planner

Or..

On the Card Studio Tools menu,
click Event Planner.

Go from Event Planner to e On the Event Planner Go menu,
Card Studio o) click Card Studio.

Starting Event Planner from Windows

If you're not in Card Studio and you want to check something on your Calendar or
in the Address Book, you can start Event Planner from Windows.

| Click the Start button.

2 Point to Programs, point to Sierra, point to Event Planner, and click Event
Planner. The Event Planner Calendar opens.

Note: You can also start Event Planner Reminders by double-clicking the Event
Planner Reminders icon or right-clicking the Event Planner Reminders icon and
clicking Run Event Planner.

Closing Lvent Planner

On the File menu, select Quit. Or, click the Close button on the right corner of the
title bar.
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Displaying the Calendar

The Calendar is the starting point for Event Planner. Click the Event Planner icon on
a Card Studio screen. Or, click the Start button on the Windows taskbar, then point
to Programs, point to Sierra, point to Card Studio, and click Event Planner.
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What s on the Calendar?

The Calendar screen shows a graphic calendar on the right side of the screen. When
you first go to the Calendar, the selected day is the current day. The selected day
changes if you click a day block on the calendar display.

The left side of the screen contains a Details list of the events and reminders for a
selected day. Remember the following definitions.

* Event—An occasion on a certain day.
* Reminder—A notice about an upcoming event.

If you click an event or reminder in the Details list, a Details note with additional
information appears under the list.

Holidays are listed at the bottom of the Calendar day blocks and under Events on
the Details list. Special icons can also appear on the day blocks.
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Calendar lcon Indicates Description

Reminder Reminders display from | to 30 days prior to an
event; you select the time period you want.
For example, you may have entered a note about
your high school class reunion as well as your
daughter’s weekly music lesson.

Anniversary  Names for the anniversary are listed in the bottom
' of the day block. The anniversary number is
included if the date of the original event is entered
in your Address Book.

Birthday The birthday person’s name is listed in the bottom
7 of the day block. The birthday number is included
if the person’s birth year is entered in your
Address Book.

Remember that the hints in the box at the bottom of the screen provide informa-
tion about buttons and boxes on the screen. The Help question mark accesses step-
by-step information about using Event Planner.

Customizing Your Calendar

You can control which holidays and icons display on your Calendar. It's easy to add
or remove displayed holidays.

| On the Calendar screen, click Options. Or, from the Edit menu, click Options.
The Options dialog box appears. The currently selected holidays are marked
with a check mark.

2 Define the holidays you want on your Calendar.
* To turn on all holidays, click Select All.
* To turn off all holidays, click Unselect All.
* To turn off an individual holiday (marked with a check mark), click the name.
* To turn on an individual holiday, click the name.

Remember to use the scroll arrows to move through the holiday list.
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3 View the Display On Calendar area on the left side of the screen. Remember

that icons with a check mark appear on your Calendar. Click the selection box
for any icon that you do not want to display. (Events are always listed on the
Calendar; the selection box only affects whether or not the icon appears.)

4 When you finish selecting the holidays and icons you want displayed, click OK.
The Calendar opens.
Calendar Notes

Notes are used to enter any events you want to remember other than a birthday,
anniversary, or holiday. Events can be one-time occasions or repeating appoint-
ments. You can request reminders for notes. All events are shown in the Details list
on the left side of the Calendar screen.

You can enter two types of text for notes:

Subject—Identifies the note. This information appears on the Calendar block
and on the Detalls list on the left side of the Calendar screen.

Message—Additional text about the subject. To see this information, you must
click the note in the Detalils list at the top of the left side of the Calendar screen.
Then, the message appears in the Details note below the list.

Other options for your note include:

Add Names—Associates people from your Address Book with a note. For
example, you may want to associate your brother and your cousin with another
relative’s birthday party as a reminder to call them with the details. (For more
information on the Address Book, see “Using the Address Book.")

Repeat Note—Controls how often the note is displayed on your Calendar.
Normally this is set to “Does not repeat,” indicating a one-time-only event.
However, you have the choice of having the note repeat on a recurring yearly,
monthly, or weekly basis.

Remind—Enables you to define how many days in advance you want to be
reminded of the upcoming event. You can choose from | to 30 days. Reminders
display when you first start Windows and also on the Detalils list on the left side
of the Calendar screen.
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Adding a New Note

| On the Calendar screen, select the date for the note. (If the month and year for
the note are not displayed on the Calendar screen, click the left or right arrow
beside the name of the month and the year until the correct month is displayed.)

2 Move the pointer over the day of the note and double-click. Or, click the day
block for the note, and click Add A Note. A blank note appears.
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3 Type the subject of the note in the Subject area. This is the information that dis-
plays in the Calendar day block and Details list. Try to keep the subject brief (for
example, “Class Reunion”) because the day block is such a small area.

4 Type a message for the note, if needed. (For example, type “Red Robin
Restaurant, 7:30. Take camera. Call Bob for directions.”)

5 If you want to add people to your note, repeat the note, or set a reminder for

the note, see the following sections. If you have finished with your note, see
“Saving a Note" for instructions.

Adding Names to a Note

You can associate a note with people in your Address Book. For example, you may
want to include names from a party guest list. (For information about using the
Address Book see “Using the Address Book.”)
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| Click Add Names on the Note screen. The Address Book list opens. A check
box appears next to each family name, family member name, and each individual.

2 Click the box for each name you want associated with the note. (You can click
just the family name. The boxes next to the family members disappear. If you
change your mind, click again on the family name to remove the check mark.)

3 Click OK to return to the Note screen. The names you selected appear.

Repeating a Note

Because many events (like soccer practice and PTA meetings) occur on a regular
basis, you can choose to have a note repeat.

| Click Repeat Note on the Note screen. The Repeat Note dialog box appears.

2 Click the Yearly, Monthly, or Weekly option you want. Duration selection
options appear.
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3 Click No Stop Date if you want this note to continue indefinitely. Or, click Set
Stop Date if the note ends on a specific date. Or, click Set Duration if you want
the note to apply to a specific time frame. If you selected either Set Stop Date
or Set Duration, another selection area opens.

4 If necessary, use the left and right arrows to set the duration or stop date for
the reminder.

5 Click OK to return to the Note screen.

Requesting Reminders

You can be reminded of an event for several days in advance. Reminders open in a
special box every day. Reminders are also listed in the Details list on the left side of
the Calendar screen and indicated by a light bulb on the Calendar day block.

Note: You must set a reminder for an event to appear in Event Planner
Reminders. Otherwise, it only appears on your Calendar.

| Click the Remind Me box on the Note screen.
2 Use the left and right arrows to adjust the number of days for the reminder.

Note: The maximum number of days for the reminder depends on the frequen-
cy of the event. If the event repeats weekly, three is the maximum number of
reminders days. If the event repeats every other week, seven is the maximum
number of reminders days. If the event repeats monthly, fourteen is the maxi-
mum number of reminders days.

Saving a Note

» Click Save to save the note and return to the Calendar (or click Cancel if you
change your mind). Your note will display on the appropriate date.

Working with Existing Notes
Existing notes must be accessed from the left side of the Calendar screen. Once a
note is displayed, you can choose to change or delete it.
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Changing a Note

Move the mouse pointer to the Calendar day block with the note you want to
change, and click. The note is listed under Events on the Details list on the left
side of the Calendar screen.

Click the note in the Details list you want to change. The existing note informa-
tion appears.

Click the Details note below the Events list. A note editing screen appears.
Make the necessary changes.

Click Save. Or, if the note is a repeating note, click This Date Forward to have
all future notes changed. Or, click This Date Only to change the note for one
day and leave it unchanged for all other days. The Calendar opens.

Deleting a Note

Move the mouse pointer to the Calendar day block with the note you want to
delete, and click. The note is listed under Events on the Details list on the left
side of the Calendar screen.

Click the note in the Details list you want to delete. The existing note informa-
tion appears.

Click the Details note below the Events list. A note editing screen appears.

If the note is not a repeating note, click Delete Note. If the note is a repeating
note, click Beginning To End to delete all occurrences of the note. This option
deletes all previous and future references. If the note is a repeating note, click
This Date Forward to leave previous occurrences of the note on your Calendar.
Use this option when you want to save previous references for your records. A
confirmation message appears.

Click Yes. The Calendar opens.

Printing Your Calendar

You can print the Event Planner Calendar. You can choose to print a |2-month
pocket calendar or a full-size calendar for one or more months. You can also print
calendars with special designs.
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With the Calendar displayed, click Print. Or, from the File menu, click Print. The
Print Calendar dialog box appears.
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Select the type of calendar you want to print.
Select your printer.

Select the paper source.

Select the paper size.

If you need to make changes using the Windows Printer Setup window, click Set
Up.

Choose the paper orientation. The Calendar prints best in a horizontal format.
Place the paper in the printer.

When you are ready, click Print Now. If you are printing a pocket calendar, see
“Printing and Folding a Pocket Calendar.” See “Printing Tips” for tips on printers,
printing, and choosing paper.

Printing and Folding a Pocket Calendar

The pocket calendar is designed to be printed on both sides of a piece of paper.
This means that usually you must print one side, flip the paper, then print the second
side.

2

With the Planner Calendar displayed, click Print. Or, from the File menu, click
Print. The Print Calendar dialog box appears.

Click Pocket Calendar.
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3

When you have completed the other print options and are ready, click Print
Now. The standard printing message appears. Then a special message about the
pocket calendar appears. Click OK to continue.

[

Notice

The podket calendar 15 printed an both

sides of the same sheet of paper. Please

wait for side one to finish, then click OK
when you are ready to print side twa,

o N o L,

9

Take the printed page from the output tray and place it in the input tray.
Whether you should place the already-printed side face up or face down
depends on the printer. For more information, see “Printing on Both Sides of the
Paper.”

Click OK to print the second side.
Trim the edges along the dark line.
Cut the paper into four pieces along the dark lines.

Stack the four pieces of paper neatly. (Hint: from top to bottom, the right-hand
sides should be: the cover, January, March, then May.)

Staple the pocket calendar at two places along the center line.

|0 Fold the paper at the center.
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Using the Address Book

You can enter much more than just standard mailing and phone information in the
Address Book. For example, you can also include the following:

* An e-mail address. E-mail addresses entered in the Address Book appear on the
Addressing screen when you e-mail a card.

* Mailing names. Mailing names are options for addressing envelopes. For example,
for the Smith family, you can have “The John Smith Family’” as a mailing name
and “Mr. and Mrs. J. Smith and Family” as an alternate mailing name. All optional
mailing names appear in a selection list for your use when printing envelopes.

* General comments. Use the Additional Information button to record and review
information for a person or family in the Address Book (for example, the family
may leave for a two-week vacation every year on July 4).

The Address Book is also used to enter birthday and anniversary dates.

Entries in the Address Book are either for a family or an individual. A family is a
group of people living at one address. The people in the family share only a main
address. Family members can have different last names, e-mail addresses, and phone
numbers.

An individual is one person at one address. You can easily move individuals into an
existing family or change a family member into an individual without losing the basic
information you've already entered.

Once you have names in your Address Book, they can be attached to notes you
create in the Calendar or used for addressing when you print envelopes and labels.

Displaying the Address Book

The Calendar is the starting point for going to the Address Book.
| Click the Event Planner icon on the Button bar at the bottom of the Card Studio
screen. Or, on the Tools menu, click Event Planner. Or, click the Start button on

the Windows taskbar, then point to Programs, point to Sierra, point to Event
Planner, and click Event Planner. The Calendar opens.
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2 On the Calendar screen, click Address Book. Or, from the Go menu, click
Address Book. An index page for the Address Book opens.
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Working with Individuals

Remember that in Event Planner, an individual is one person living at one address. If
you want to add a person to a family, see the instructions in “Adding a New
Member to a Family” or “Moving an Individual into a Family.”

Entering Basic Information About an Individual

| Click Add Individual in the Address Book. An information screen opens.
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2 Type the name, phone number, and address (including one for e-mail) of the
person. You can use TAB, ENTER, or the mouse to move from one box to
another.
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3 If you want to enter birthday, anniversary, holidays, or additional information for
this individual, see the following sections. Or, if you're through entering informa-
tion for this person, follow the instructions in “Saving an Entry for an Individual.”

Lntering a Birthday for an Individual

| On the information screen for the person, click Birthday. The mailing address
lines close, and a check box appears.

2 Click Enter a Birthday. The screen changes so that you can select the date.
Use the left and right arrows to adjust the month and day.

4 If you enter the birth year, your Calendar also shows the birthday number (for
example, “Ron’s 26th Birthday").

* If you know the year, use the left and right arrows to adjust it. Or, type the
year.

* If you do not know the year, click Birth Year Known to clear the selection.
The check mark is removed and the year line closes.

Note: You can always enter a year later if you want.

5 If you want to be reminded about the birthday, click Remind Me. The screen
changes so that you can select the number of days for the reminder.

Use the left and right arrows to adjust the number of days (I through 30).

7 If you want to see the address line again, click Address.

Lntering an Anniversary for an Individual

You can enter an anniversary date for an individual. You may want to remember a
graduation, starting a job, or any other major event. An anniversary date for an indi-
vidual will not be associated with another person.

| On the information screen for the person, click Anniversary. The mailing address
lines close, and a check box appears.

2 Click Enter An Anniversary. The screen changes so you can select the date.
Use the left and right arrows to adjust the month and day.

4 If you enter the wedding year, your Calendar also shows the anniversary num-
ber (for example, “Ron’s 26th Anniversary”).
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* If you know the year, use the left and right arrows to adjust it. Or, type the
year.

* If you do not know the year, click Wedding Year Known to clear the selec-
tion. The check mark is removed and the year line closes.

Note: You can always enter a year later if you want.

5 If you want to be reminded about the anniversary, click Remind Me. The screen
changes so that you can select the number of days for the reminder.

Use the left and right arrows to adjust the number of days (I through 30).

If you want to see the address line again, click Address.

Lntering a Holiday Reminder for an Individual

You can choose to associate holidays with any person in your Address Book. For
example, you may want to send a card to a special aunt on Mother’s Day.

| Click Holiday. The alphabetical Holiday List opens.
2 If necessary, click the arrows to scroll the list.

Click the holiday. A check mark appears in the box, and the screen changes so
that you can set the number of days for the reminder.

4 If you want a reminder, use the left and right arrows to adjust the number of
days (I to 30).

5 If you want to see the address line again, click Address.

Entering Additional Information for an Individual

It's easy to forget gifts you have given previously or something special a person has
mentioned wanting. Event Planner helps you with this information. Use the
Additional Information space for any facts you want to remember.

| Click Additional Information. A blank box appears.
2 Type the information you want to remember.

3 Click Address if you want to see the Address lines again.
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Saving an Entry for an Individual

| When you finish entering information about the individual, click Done. An index
page for the Address Book opens.

2 If you are through working with the Address Book and want to return to the
Calendar, click Done. The Calendar opens.

Working with Families

A family is a group of people living at one address. The people in the family (called
family members) share only a main address. Family members can have different last
names, e-mail addresses, and phone numbers.

If you want to enter families in your Address Book:
* First, create the family.
* Then, add the family members.

When you create a family, you enter a last name (this can later be changed for each
individual) and a mailing address. Family members are added by creating a new list-
ing for a person or by moving an existing individual into the family. You do not lose
any basic information, such as a phone number or birthday, when you move some-
one into a family. However, the individual does assume the family's address.

Lntering Basic Information About a Family

| Click Add Family in the Address Book. A general information screen for the fam-

ily opens.
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2 Type the last name, phone number, and address (including one for e-mail). You
can use TAB, ENTER or the mouse to move from one box to another.

3 If you want to set holidays for the family, follow the instructions in “Entering a
Holiday Reminder for an Individual.”

4 If you want to enter additional information for the family, follow the instructions
in “Entering Additional Information for an Individual.”

5 If you want to add members to the family, see the following section.

Or, if you're through entering family information, follow the instructions in
“Saving an Entry for a Family.”

Adding a New Member to a Family

Use these instructions to add a new person to a family. If you want to move an
existing individual into the family, see “Moving an Individual into a Family.”

| If you have just finished entering family information, skip to Step 3. If the family
information page is not displayed, click a tab identifying the family’s last name ini-
tial. The index page for the tab opens.

2 Click the family entry on the index page. The family listing appears.

Click Add Family Member. The right page changes so that you can enter infor-
mation for the new family member. You can change the last name and phone
number, if necessary; you can also add an e-mail address. You cannot change the
mailing address.

4 If you want to enter a birthday for the family member, follow the instructions in
“Entering a Birthday for an Individual.”

5 If you want to set holidays for the family member, follow the instructions in
“Entering a Holiday Reminder for an Individual.”

6 If you want to enter additional information for the family member, follow the
instructions in “Entering Additional Information for an Individual.”

7/ Repeat Steps 3 through 6 to enter additional family members.

When you are finished adding family members, click Done. An index page for
the Address Book opens.
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Moving an Individual into a Family

You can move someone you've already entered as an individual (or as a member in
another family) into a family. It's easy, and you won't lose any of the information you
entered.

| With the family information displayed, click Get Existing Person. The Get Existing
Person list appears, showing every person in your Address Book.

2 Select the name of the person you want (you can click more than one name),
then click Move To Family. The person is changed from an individual to a family
member automatically (or transferred from the other family). No information is
lost; however, the individual does assume the family's address.

Lntering an Anniversary

You can enter an anniversary for an individual or for a couple. Couples must be
members of the same family and both must be in the Address Book. While you can
enter an anniversary date for an individual, you cannot associate the anniversary with
another person.

| Display the information screen for either an individual or a family member, and
click Anniversary. The mailing address lines close, and a check box appears.

2 Click Enter An Anniversary. The screen changes so you can select the date.

Note: The Anniversary Shared With box will not display for an individual.
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3 Use the left and right arrows to adjust the month and day.

4 If you enter the anniversary year, your Calendar also shows the anniversary
number.
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* If you know the year, use the left and right arrows to adjust it or type it in.

* If you do not know the year, click Wedding Year Known to clear the selec-
tion. The check is removed, and the year line closes.

Note: You can always enter a year later if you want.

5 If you want to be reminded about the anniversary, click Remind Me. The screen
changes so that you can select the number of days for the reminder.

Use the left and right arrows to adjust the number of days (I through 30).

If you are entering an anniversary for a couple, click the name of the family
member sharing the date.

8 Click Done to return to the Address Book screen.

Changing a Family Member to an Individual

In your Address Book, you can easily change the family status of a person (when
someone moves into their own home, for example). None of the information that
you entered for that person is lost. (To change an individual to a family member, see
“Moving an Individual into a Family.”)

| Display the family listing screen, and click the name of the family member.
2 Click Change To Individual. A confirmation message appears.

3 Click Yes. The person is changed to an individual. You'll need to change the
address and phone number for this new listing.

Saving an Entry for a Family

| When you have finished entering information about the family, click Done. An
index page for the Address Book opens.

2 If you are through working with the Address Book and want to return to the
Calendar, click Done. The Calendar opens.

Keeping Vour Address Book Current

You meet new people and want to stay in touch. Relatives move. Friends get mar-
ried. There are many reasons you'll have to update your Address Book.
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Changing Address Book Entries

To change information such as name, phone number, birthday, or reminders, simply
display the screen on which you entered the data and make the change. It's that
easy!

| In the Address Book, click a last name initial tab for the family, family member,
or individual you want to change.

2 Click a family or individual entry on the index page. The family or individual
information screen opens.

3 If you want to change information for an individual family member, click a family
member name. The family member information screen opens.

4 Make any changes you want.

Click Done to keep the changes you made. An index page for the Address Book
opens.

Deleting Address Book Entries

You always have a chance to change your mind before a deletion is made.

| In the Address Book, click a last name initial tab for the family, family member,
or individual you want to delete.

2 Click a family or individual entry on the index page. The family or individual
information screen opens. The family name is selected.

3 If you want to delete information for an individual family member, click a family
member name from the family listing. The family member information screen
opens.

4 Click Delete This Page. A confirmation message appears.

Click Yes to make the deletion. If you deleted an individual or an entire family,
an index page for the Address Book opens. If you deleted a family member, the
family information screen opens.
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Printing Your Address Book

You can print the names and addresses from your Address Book.

| In the Address Book, click Print. Or, from the File menu, click Print. The Print
Address Book dialog box appears.
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Select your printer.
Select the paper source.

Select the paper size.
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If you need to make changes using the Windows Printer Setup window, click Set
Up.

Choose the paper orientation.
7/ Place the paper in the printer.

When you are ready to print, click Print Now.

LEvent Planner Reminders

Every day, the Event Planner Reminders automatically notify you of upcoming events
for which you requested reminders.

The Event Planner Reminders program opens automatically when you start your
computer or at the beginning of each day if you don't turn off your computer. It can
also be opened by double-clicking the icon on the Windows taskbar. (If the icon
does not appear on the Windows taskbar, click the Start button on the Windows
toolbar, then point to Programs, Sierra, Hallmark Comedy Card Studio and click
Event Planner Reminders Tray Icon. Then, double-click the icon on the Windows
taskbar.)
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You can also use the icon on the Windows taskbar to run Event Planner, to set
Reminder options, or to close Reminders. Right-click the icon to open a menu con-
taining these selections.

The Reminder window displays the first reminder for the day, with any messages
you entered. If there are additional reminders, use the scroll arrows below the note
to see them.

Options for Reminders

You can set Reminder options that determine when the Reminder screen opens.
| Right-click the Reminder icon on the Windows taskbar, and click Options.

2 Select the Only At Startup option to display Reminders only when you start
your computer. Or, select Startup & Time to display Reminders either when you
start your computer or at a certain time of each day. If you choose this option,
select the time of day you want the Reminders to appear.

3 Click OK.
There are also some options available on the Event Planner Reminder screen:

*  Don't Remind Me—You will not be reminded of the displayed event again. (If
you choose, you can set the reminder again on the Note screen. For more
information, see “Requesting Reminders.”)

* Exit—Closes the Reminders and takes you to the Windows desktop.
* Calendar—Closes the Reminders and displays the Calendar.

* Card Studio—Opens Card Studio and takes you to the Activity screen so that
you can design a card or other special creation.

*  Print—Opens the Print screen with special options for Reminders in Step .
(This option only appears if there are reminders for the date.)

Select the appropriate options, and click Print Now.
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Hallmark Card Studio™ | Working with Other Databases

Workiﬂg with Other Databases

Event Planner can accept comma-separated data (.csv) from other database pro-
grams. Information such as names, addresses, phone numbers, and text entered in
the Additional Information box can be imported.

You can also export information from your Event Planner Address Book for use in
other database programs that recognize comma-separated data.

Note: Event Planner must be closed before importing new data.

Importing a Database

| Click the Start button, point to Programs, point to Sierra, point to Event Planner,
and click Event Planner Import. The File Import dialog box appears. It looks simi-
lar to the File Export dialog box.

2 Select the correct drive and folder. Type the name of the file to be imported,
and click Open. A message displays the first record found in the file.

3 If the information displayed in the message area on the second (and subsequent)
line(s) is a label (for example, Last Name, First Name, Street Address, and so
forth), click Label. If the information displayed in the message area on the second
(and subsequent) line(s) is data (for example, Jones, John, 1234 Main Street, and
so forth), click Data. The Event Planner Import dialog box appears. The contents
of the first field of the first record are displayed on the left. The box in the mid-
dle contains the Event Planner field names.
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Hallmark Card Studio™ | Working with Other Databases

4 Click the label that best matches. If the contents is for a type of data not listed
(for example, an e-mail address), click None Of The Above.

5 Click the >> button. The matching entry moves to the box on the right.
Continue until you assign all the fields.
7 Click OK.

Exporting a Database

| Click the Start button, point to Programs, point to Sierra, point to Event Planner,
and click Event Planner Export. The File Export dialog box appears.

2 Change the drive and folder, if necessary.
If you want the data exported to a file other than planner.csv, enter the name.

4 (lick Save. The file is created. The first record of the file is a header record with
the names of the fields.
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Hallmark Card Studio™

Contacting Sierra On-Line

Contacting Sierra On-Line

Technical Support
Noreh America

Sierra On-Line offers a 24-hour automated technical support line with recorded answers to the most
frequently asked technical questions. To access this service, call (425) 644-4343, and follow the
recorded instructions to find your specific topic and resolve the issue. If this fails to solve your prob-
lem, you may still write, or fax us with your questions, or contact us via our Web site.

Main: (425) 644-4343

Monday-Friday, 8:00 am.- 4:45 p.m. PST
Fax: (425) 644-7697
http://www.sierra.com
support@sierra.com

Sierra On-Line

Technical Support

P.O. Box 85006

Bellevue, WA 98015-8506

United Kingdom
Havas Interactive offers a 24-hour Automated Technical Support line with recorded answers to the
most frequently asked technical questions. To access this service, call (01 18) 920-9111, and follow the

recorded instructions to find your specific topic and resolve the issue. If this fails to solve your prob-

lem, you may still write, or fax us with your questions, or contact us via our Internet or CompuServe

sites.

Havas Interactive

2 Beacontree Plaza,
Gillette Way,

Reading, Berkshire

RG2 0OBS United Kingdom

France

Havas Interactive France
32, Av de I'Europe

Bat Energy | (2e étage)

78 140 VELIZY-Villacoublay
France

Germany

Havas Interactive
Robert-Bosch-Str. 32
D-63303 Dreieich
Deutschland
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Main: (0118) 920-91 11
Monday-Friday, 9:00 am. - 5:00 p.m.
Fax: (O118) 987-5603
http://www.sierra-online.co.uk

Téléphone: 01-30-67-90-50
Lundi au Jeudi de 10h a 19h
Vendredi de |0h a 18h

Fax: 01 30 67 90 65
http://www.sierra.fr

Tel: (0) 6103-99-40-40

Montag bis Freitag von 10 - 19Uhr
Fax: (0) 6103-99-40-35

Mailbox: (0) 6103-99-40-35
http://www.sierra.de
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Hallmark Card Studio™

Spain

Havas Interactive Espafia
Nuestra Senora de Valverde
Ne 23

28034 Madrid

Spain

ltaly

Contattare il vostro distributore.

Contacting Sierra On-Line

Tech Support Teléfono: 91 735 24 37

Soporte técnico de lunes a viernes de 09:30 a 15:00
y de 16:00 a 18:30

http://www.havasinteractive.es

Soporte Tecnico: soporte@havasinteractive.es
Comercial: comercial@havasinteractive.es

Customer Service, Support, and Sales

United States

Sierra Direct
P O Box 629001

El Dorado Hills, CA 95762-9972

United Kingdom

Havas Interactive

2 Beacontree Plaza,
Gillette Way,

Reading, Berkshire

RG2 0BS United Kingdom

France

Havas Interactive France
32, Av de I'Europe

Bat Energy | (2e étage)

78 140 VELIZY-Villacoubaly
France
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U.S.A. Sales Phone: (800) 757-7707
Hours: 24 hours a day, 7 days a week
International Sales: (425) 746-5771

Hours: Monday-Friday 8 AM to 4 PM PST
FAX: (916) 939-1010

E-mail: customer.support@sierra.com
http://www.sierra.com

Main: (0118) 920-91 11

Monday-Friday, 9:00 am. - 5:00 p.m.

Fax: (0118) 987-5603

Disk/CD replacements in the UK. are £6.00,

or £7.00 outside the UK. Add “ATTN.: Returns.”

Téléphone: 01-30-67-90-50
Lundi au Jeudi de 10h a 15h
Vendredi de 10h a 18h

Fax: 01-30-67-90-65
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Hallmark Card Studio™ | Contacting Sierra On-Line

Germany

Havas Interactive Tel: (0) 6103-99-40-40
Robert-Bosch-Str. 32 Montag bis Freitag von 10h - 19Uhr
D-63303 Dreieich Fax: (0) 6103-99-40-35
Germany

On-Line Sales

CompuServe United Kingdom: GO UKSIERRA

CompuServe France: GO FRSIERRA

Internet USA: http://www.sierra.com
Internet United Kingdom: http://www.sierra-online.co.uk
Internet France: http://www.sierra.fr

Internet Germany: http://www.sierra.de

Disk and/or Manual Replacement
Product Returns/Replacement*:

Product Returns:* CD/Documentation Replacement:
Havas Interactive Havas Interactive

Sierra On-Line Returns Sierra On-Line CD/Doco Replacement
4247 S. Minnewawa Ave. 4247 S. Minnewawa Ave.

Fresno, CA 93725 Fresno, CA 93725

Note: To replace your CD(s) please send only the damaged cd and copy of your dated Receipt, if
less then 90 days. After 90 days please include a $10.00 handling fee along with the CD(s). For docu-
mentation replacement, please include a $5.00 handling fee and a photocopy ONLY of either your
disk or CD. Payment should be made at the time of your request. Sorry, no credit cards.

* Returns to this address valid in North America only.
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